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1 BASS Project User Guide

1.1 Introduction 

BASS Project is a Windows based application for amateur astronomical 
spectroscopy. The application was designed with new users in mind and is able to 
perform all of the standard spectroscopic processing tasks (e.g. calibration, 
instrument correction, continuum removal, background subtraction etc.) with 
relatively few steps and without the need to save intermediate files.

BASS Project provides a rich set of tools for spectral profile processing and 
presentation of single or multiple spectra.  It also provides image processing 
functions to crop and correct for rotation, tilt, smile and slant distortions for FITS and 
RGB (e.g. bitmap, jpeg & png) image formats. RGB files are automatically imported 
into a FITS format which makes it easy for new users to get started using a DSLR or 
web cam. Various text format profiles, such as DAT or UVES are also fully 
supported. In addition, tabular TFITS files can also be loaded.

With image stacking and functionality to submit to BeSS and other online databases 
provided, BASS Project can be considered to be a fully comprehensive ‘one stop 
shop’ for all your pre-processing and data reduction needs.
 
A BASS ‘project’ consists of one or more spectral images and their associated 
profiles, to which reference spectra, Planck temperature curves, element lines, and
annotation labels can be presented.

For details of historical changes made to BASS Project see Appendix D – 
Amendment History

There is a Yahoo group at http://uk.groups.yahoo.com/group/astrobodger for users to
access downloads, post their work and ask for help.

1.2 Installation

BASS Project is a .NET application that should run on Windows XP, Windows 7, 
Windows 8 or Windows 10 (32 or 64bit) PCs.

Download the latest MSI setup & installation package from the BASS Project 
downloads section of the following link:
https://uk.groups.yahoo.com/neo/groups/astrobodger/links/all

Save the MSI file to a temporary location and then run accepting the default options.  

Microsoft .NET 4 is the only prerequisite required; this is normally already provided 
on most PCs. If not, the installer will prompt for it to be downloaded.

To minimise issues to do with Windows 7(and above) access permissions, the 
default installation path is C:\Astrobodger\BASS Project. If this is changed to be 
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under “C:\ Program Files\” then it may be necessary to provide administrative 
access and or set compatibility to XP.

Installation will create a Start Programs group that contains links to the user guide 
and the link to Uninstall.

The MSI will install the 32-bit version of the application, BASSProject.exe. Users on 
64-bit windows can optionally download and install the 64-bit version.

Check if there are patch release folders having a higher version than the MSI file and
follow the release notes to apply updates when required.  The release notes may 
also describe new functionality that has not yet been included in this user guide.

There are some additional components below that are not included with the MSI 
installer. 

1.2.1 PythonRunFiles

The PythonRunFiles zip folder contains advanced tools such as 3D plots and 
barycentric velocity calculations. 

Download the zip from: 
https://www.dropbox.com/s/l9bo0fywonbckez/PythonRunFiles.zip?dl=0

Extract the contents of the PythonRunFiles in the zip file into your 
C:\Astrobodger\BASS Project\Scripts\PythonRunFiles folder as per screenshot 
below.

BASS Project 1.9.9 page 6 of 168

https://www.dropbox.com/s/l9bo0fywonbckez/PythonRunFiles.zip?dl=0


For clarification – you don’t need to install the Python language. The zip file includes
compiled executables and run time dependencies. 

1.2.2 Miles reference library

The Miles reference spectra library can be used as a higher resolution alternative to 
the Pickles reference spectra that are provided with the BASS Project MSI installer.

Download the Miles library zip from:  
https://www.dropbox.com/s/oqk4omkrjpslopl/MilesLibraryBASS.zip?dl=0

Extract the zip contents into the C:\Astrobodger\BASS Project\Reference\Miles folder
as per screenshot below.
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2 Functionality

BASS Project uses a single main screen interface with additional pop-up forms 
displayed as required. Functionality is available via traditional menus, the main 
toolbar and context sensitive “right mouse click” menus. 

Most of the icons, controls and buttons incorporate a short ‘tool tip’ description when 
hovered over. The main screen loaded with an example project is shown below. 

The screen is divided up into sections shown in the diagram below.
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One or more spectral images (in FITS, RGB or DAT formats) can be loaded at any 
time. When an image is loaded, it is presented (as either a raw image or binned view)
in an image strip under the toolbar. The spectral profile associated with the image is 
then plotted in the chart area. Clicking on one of the image strips will make it active. 

The display of an image as a raw image or binned view is determined by the Image 
Strip view drop down list selection (in the centre of the toolbar) and is detailed in its 
own section later.

The ‘active’ image strip is shown highlighted with a yellow border that also shows the 
sequence number starting from 1.  The majority of popup forms (e.g. Rotation, Image
Resize, Measurements) act upon the active image selected and many have an option
to apply changes, such as geometric corrections consistently to all the loaded 
images.

The first profile (sequence =1) has special significance since it determines the x-axis 
pixel or wavelength range, the y-axis scaling and calibration status of the chart. 
Where displayed, the y-axis values are based on the first profile. By default, 
subsequent profiles are automatically scaled to fit the chart, however,  scaling 
options can also be manually configured.

The LH status bar shows pixel, wavelength (if calibrated) and profile intensity 
information for the active image corresponding to the position of the mouse.

The RH status bar shows the image size and dispersion (if calibrated) of the active 
image. A one dimensional profile will show height H=1.

The chart area shows profiles associated with loaded images. The derivation of a 
one dimensional profile from a two dimensional image is detailed later.

2.1 Menu and toolbar function

The menu and toolbar functions are grouped info functional areas

2.1.1 Project File Functions

A BASS Project is saved as a (*.bass) text file that contains the following:

 Chart settings (e.g. wavelength unit, title, colours, fonts, x and y axis settings) 
 Links  to one or more spectral profiles using absolute paths.
 Spectral profile settings (calibration options, instrument correction options, 

scaling, displayed caption, active & background regions, colour & style)
 Links to one or more reference spectra and settings (caption, colour & style)
 Planck temperature curves and settings
 Element labels and annotation settings.

The project function icons allow projects to be opened, and saved. 
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The New, Open & Save project functions are also available via the File menu. 

Edit Chart (project) settings are under the Chart menu. Chart settings are described 
in their own section.

2.1.2 File menu

The File menu items provide an alternative means to access toolbar functions for 
projects or image files. Many of the more commonly used functions are available 
from the toolbar or have short cut key strokes. For example Ctrl+O will open images.

Menu items will be enabled or disabled according to context, e.g. Save Image is 
disabled if there are no images loaded.

When starting out, a new user will typically open and save images before they move
onto using projects.
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New Project -  Will start a new empty project with default project options. Will prompt 
in case there are unsaved changes to images.

Open Project or Bundle – Will prompt in case there are unsaved changes to images 
and then open a Windows File dialog to choose a Project (*.bass) or Bundle (&.bun). 
See 2.1.2.1 BASS Project Bundle section.

Save Project or Bundle -   Will prompt in case there are unsaved changes to images 
and then open a Windows File dialog to save a Project (*.bass) or Bundle (&.bun). 
See 2.1.2.1 BASS Project Bundle section.

Note: There is no separate Save Project function without a file dialog. Just overwrite
your file.

Search for Projects or Images – See 2.1.5  

Add/Open Images -  Will open a Windows File dialog for a user to select one or 
multiple images to load.

Add/Open Colour Image to RGB channels -  Will open a Windows File dialog to 
select a single RGB (bmp, png, jpg) file to load as separate red, green and blue 
channels.

Stack Images – Combine and/or process multiple images. See 2.8 

Save Image As – Opens Windows File dialog to saves the selected image to disc. 

Note: There is no separate Save function without a file dialog. Just overwrite your 
file.
 
Save AS 1D Profile – Converts a two dimensional image to a one dimensional profile.

Remove Image – Removes selected file. User is prompted for unsaved changes. 

Recent Projects – Provides quick access to the last 20 projects loaded

Recent Profiles – Provides quick access to the last 20 images loaded

Exit - Will prompt in case there are unsaved changes before closing the application.
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The Profile Functions section 2.1.6 provides more details on using project and image 
files.

2.1.2.1 BASS Project bundle

A bundle file (*.bun) is proprietary binary format that contains all profiles and settings 
associated with a project as a single file. This is the recommended way to share 
BASS projects with other users.

Saving a bundle

The save project file dialog includes a Save as "bundle" type drop down option. It is 
recommended you first save the project normally with a .bass extension before 
saving as a bundle.

Browse to set the filename and path and then use the Save as type drop down to 
select the ‘BASS Bundle (&.bun)’ option. Make sure the file extension is also 
changed to .bun.

This will save the project, each profile + info.bas file, labels, etc. into a single file that 
you can send to or share with another BASS user. 

Note: It is recommended that you test the bundle you have created will open 
correctly before sending it out.

Opening a bundle

Click on the Open Project menu from the File menu (or toolbar icon)  to show the 
Open BASS Project  file dialog.   
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Browse to find your bundle file and click OK.

 

The application then loads the unpacked BASS file complete with profiles settings 
etc. 

2.1.3 Chart Menu

The Chart menu provides access to the functions below
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 Refresh Chart – redraws the chart. Also accessible via the F5 key.

 Copy Chart to clipboard - copies the chart to the Windows clipboard for 
pasting into another application.

 Save Chart to file – Saves the chart to an RGB picture file.

 Copy Image Strips to clipboard – Copies all the image strips as a single 
picture. This avoids having the yellow border visible (if you took a screenshot) 
and allows a picture larger than the screen size to be captured.

 Save Image Strips to file - Saves all the image strips as a single RGB picture. 
(See Copy Image Strips to clipboard above)

 Crop X-Axis range – Opens screen to selects all or a subset of the x-axis. 
Detailed in the Crop X-Axis Range section later on.

 Uncrop X-Axis range – Disables cropping to show full wavelength or pixel 
range of top profile. This function is also available on the X-Axis crop screen.

 Edit Project Chart Settings – Opens the Chart settings screen.  Detailed in its 
own section later on.

2.1.4 BASS file extensions used 

BASS uses a few proprietary file extensions. You may need to modify your Windows 
Explorer settings in order to show file extensions. Go to ‘Tools’ -> ‘Folder Options’ -> 
‘View’ and make sure ‘Hide extensions for known file types’ is unchecked.

2.1.4.1 BASS Project file

A project file is a text file that uses a four letter extension (*.bass). See Project File 
Functions section. This file should not be confused with profile information “.info.bas” 
files that hold calibration and other data per image.
 
2.1.4.2 BASS Bundle file

A bundle file is a binary file that uses a three letter extension (*.bun). See BASS 
Project bundle section
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2.1.4.3 Profile information file

This is a text file that uses a *.info.bas file extension. BASS automatically creates and
manages a small text file alongside every image file. The file is used to hold image 
specific information such as calibration coefficients and points, response corrections, 
region selections etc. that are not contained in a FITS header.

Annotated example content of a BASS image information file

When sending/sharing BASS images to other BASS users, be sure to include the 
BASS profile information files (*.info.bas) located in the same folder as your actual 
image files. Alternatively, it will be much easier to save the project as a single BASS
bundle (*.bun) file that can be emailed or shared using Dropbox or similar.  

2.1.4.4 BASS Label set

This is a *.lbl text file that contains label rendering information. See Labels Screen
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2.1.5 Search function

The Binocular icon opens the modal Search screen. (Also available under File menu)

This will search for images (in DAT, RGB & FITS formats) or complete projects 
(*.BASS) files depending on the “Filter” drop down list.

The “Folder” textbox contains the folder to search under (including sub folders). 
The Search button will look under the specified “Folder” to match text entered in the 
filter textbox, (including * wildcard).  A blank filter textbox returns all files. The results 
are shown in the grid underneath. 

One or more profiles can be selected. Clicking Open will add the selected images to 
the project (& display them in the chart). The same images can be added more than 
once (in order to simultaneously display corrected and uncorrected views of a 
profile).

For projects, only one project can be selected. Clicking Open will close any existing 
images and load the selected project. (Only one project can be open at a time).
Press the Close button to access the main screen.

2.1.6 Profile functions

An image having height=1 is technically a one dimensional profile where values from 
each column have been processed to single values (“binning”). The term “image” is 
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used loosely here. It can refer to a two dimensional image (where conversion to a 
single dimension is calculated at run time) or a one dimensional image.

The toolbar image and profile functions are shown below

Note: Functionality has increased substantially since the toolbar was created. The 
Tools menu provides access to a large number of functions that won’t fit on the 
toolbar.

Add Images – the icon allows one or more images to be added to the chart.

Colour RGB (jpg, png, bmp, tif, gif) images will be opened as black and white. The 
File menu does also provide an option to open an RGB image into separate red, 
green and blue image channels.

Stack Images – the icon opens up the Stack Images screen which allows a single 
image to be created from a set of raw images.

Save Image – the icon allows the selected image to be saved

To select an image, just click on the image strip. A yellow border will indicate which 
image strip is selected (active). The sequence number and dimensions of the 
selected image strip are displayed on the RH status bar. If the profile is calibrated, 
the dispersion in wavelength unit per pixel is also displayed.
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The three options are:
 Yes –  confirm the filename and save the image. Once saved the image strip 

is removed
 No – remove the profile without saving changes
 Cancel – abort the profile removal

Note – If the Shift key is held down when a profile is being removed then a prompt 
to actually delete the file will appear.

Edit profile settings – the icon opens the Profile Properties screen (described in its 
own section)

Crop X-axis – this opens the modal Crop X-Axis Range screen to enable you to 
zoom in on a region of the chart. This is a core feature that is critical to getting the 
most out of the application. 

Refresh Chart – Redraws the chart. The F5 key will also refresh the chart.

Image Strip View – this drop down list allows a choice of how the image list is to be 
displayed. See the Image Strips section

2.1.7 Advanced Tools functions

Calibration  –  an icon is provided to edit the existing calibration points of the top 
profile. If the profile is not calibrated then a new calibration is started.
 
The main Calibration menu is more useful than the toolbar icon since it allows a 
choice of options, including displaying calibration points on the chart.
See the Wavelength Calibration section 2.12 for details.

Math Operations  – an icon is provided to show the Operations screen.
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The main Operation file menu includes sub menus for operations plus an option to 
stack image profiles (of the same width) together to create a new 1-dimensional 
image. There is also an option to Stitch Profiles together, see Stitch Profiles section.

The result of the operation is displayed in a new image profile (added to the end of 
the list). The new image can be saved by right clicking on the new image strip and 
selecting “Save Image As” to invoke the standard File Save dialog.

Note: You will be prompted to save new images created before saving a project.

Measurement & Element lines  – an icon is provided to access the Measurement
& Element lines screen. This allows measurements from the chart to be taken and 
also allows element lines to be identified, plotted and/or displayed. See
Measurements & Elements screen section.

Reference Spectra  - an icon is provided to access the Reference Spectra 
screen. This allows one or more reference spectrum to be added to the chart. See
Continuum & Response Shaper section.
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Continuum & Response Shaper  - an icon is provided to access the Continuum &
Response Shaper screen. This allows curves to be created for instrument response 
correction and/or continuum removal. See Continuum & Response Shaper section.

Planck curves  - an icon is provided to access the Planck Curves screen. This 
allows Planck temperature curves to be added to charts. See Planck Temperature 
Curve section.

Resample Profile  - an icon is provided to access the Resample Profile screen. 
This allows a profile to be resampled and/or filtered. See Resample Profile section.

Labels  - an icon is provided to access the Labels screen. This allows annotation 
labels to be added to the chart and managed. See Labels Screen section.

Animation  – an icon is provided to access the Animate screen. This allows 
animations to be created from profiles or saved pictures. See Animation section.
 

Export Project  - an icon is provided to access the Export Project screen. This 
allows all profiles on the chart to be exported and displayed in a spreadsheet 
application. See Export Project Data section.

2.2 Chart Settings

The Chart Settings screen allows control of how the chart (project) is displayed. It is 
organised into separate tabs along the top. This screen is called from various menus 
and also by double clicking on the chart. The buttons on the base of the screen are 
common to each tab

Default – A button that stores chart settings to be reused when a new project is 
started or the application next starts. These settings are held in a file called 
“_default.bass” located in the application installation folder.

Apply – A button to apply chart setting changes made and keep the screen open.

OK – A button to applies chart setting changes made and close the screen.

Cancel – A button to close the screen.

All chart settings are saved at a project level (i.e. save a project to keep changes).
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2.2.1 Chart  Main tab 

Main   Title – text is displayed on the top of the chart area. The adjacent Save and 
Delete buttons allow titles to be reused (described in Sub Title below)

Sub Title – text to display under the Title. The adjacent Save button allows entries to 
be saved to the drop down list for reuse. The Delete button will remove a selected 
item from the drop down list

Chart height & width - The width and height of the chart can be set to any sensible 
value, such as the width of your camera sensor (in pixels). It is can be useful to 
temporarily set the width to a high value that exceeds the screen width (e.g. 4000) 
and scroll horizontally to examine features in detail or when calibrating. 

Image strip height – Specifies the height in pixels for each of the image strips (when 
not in one of the raw image strip view options).

Background chart image - Allows a background image file to be displayed in the chart
behind the profiles. No scientific value, but you can put a meaningful ‘pretty picture’, 
perhaps an astronomical photo of your target, as the background

2.2.2 Colours tab

Various colour setting options are provided to personalise your projects.
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Clicking on the coloured icons invoke standard Windows colour selection dialogs.

Wavelength Colour blend – this checkbox will blend the Background Colour with the 
colour associated with displayed wavelength range, as shown below.
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2.2.3 X Axis tab

The X axis tab allows a choice of how the x-axis captions and grid lines are displayed

Show X axis gridlines – A checkbox to enable vertical grid lines to be visible

Show X axis Minor Ticks – A checkbox to display minor ticks on x-axis

X axis raw text – A textbox to specify x axis text when the chart is not calibrated

X axis calibrated text – A textbox to specify the x axis text when calibrated. This 
supports the following place holder parameters

 {0} will display the wavelength unit symbol/abbreviation (Å, nm or μm)
 {1} will display the wavelength unit name (Angstrom, nanometer or micron)
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2.2.3.1 Doppler X Axis

Show Doppler Shift option checkbox  - allows velocity (km/s) to be presented on the 
X axis relative to a stationary wavelength. 

The Measurements screen will include velocity measurements when Doppler X Axis 
is enabled.

Rest wavelength – specifies the wavelength where velocity=0

X axis Doppler text – the X axis label text displayed when Doppler x axis is enabled. 
A parameter {0} can be used to show the rest wavelength within the x axis text.

2.2.4 Y Axis tab

The Y axis tab allows a choice of how the y-axis values and grid lines are displayed

Show Y axis grid lines – A checkbox to enable horizontal grid lines to be visible
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Show Y axis Minor Ticks – A checkbox to display minor ticks on y-axis

Y axis Labels  - drop down list allows a choice of two options:
 None – no values are shown on y-axis

 Show Values – Y axis values are shown in ADU (analogue data units) from 
the top (sequence = 01) image profile. 

Y-axis text – drop down list allows a caption, such as ‘Intensity’, to be displayed on 
the Y axis. The adjacent Save and Dustbin icons allow a list of alternative y axis 
captions to be managed.

Y-  Axis 2 Labels – A drop down list to choose to display options below
• None – no axis to be displayed on RH side of the chart
• Single RH Axis – Display axis in RH margin of the chart. RH axis values are 

from the profile with sequence number 2
• RH Axis per profile – Display a Y axis for every loaded profile. 

Y-axis 2 Text – drop down list containing  RH axis text. Multiple text can be managed
using the adjacent Save and Dustbin icons.

2.2.5 Fonts tab

The fonts tab allows the font properties of text to be changed

Border Text Font – this button opens a font selection dialog to pick the font used to 
display text on the border area outside the chart. This includes the main title, sub 
title, y axis caption and x axis caption. This does NOT include the x and y axis values
(as they have their own button). 

Note that the Main Title font size will be 3 points larger than the value selected.
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Legend Font – this button opens a font selection dialog to pick the font used to 
display the captions of loaded profiles in the legend.

Label + Notes Font – this button opens a font selection dialog to pick the font used to 
display Labels and Notes.

Axes Value Font – this button opens a font selection dialog to pick the font used to 
display values on the x axis and y axis (if enabled)

Note Stick to common fonts such as Arial or Sans Serif if you plan to share your 
project with other users. Exotic fonts may be not be installed on other users PCs.

2.2.6 Legend tab
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The ’Show Sequence in Legend’ checkbox determines if the profile captions listed in 
the legend are prefixed with the sequence number.

The ‘Show line style in legend’ checkbox will show a section of the line rendered 
using the line style and marker.

Showing the sequence number or line style will be useful when there are a large 
number of profiles loaded and you need to know which is which.

Legend Display Option - This allows a choice of how the text is displayed. The 
options are:

 Transparent text 
 Opaque text
 Opaque text + border (this is the default)

2.2.7 Advanced tab

Wavelength Unit – The drop down list provides a choice of wavelength unit used. The
current options are:

 Angstrom  1Å = 1 x 10-10 metres
 Nanometer 1nm = 1 x 10-9 metres
 Micron 1μm  = 1 x 10-6 metres

The following settings are sensitive to the wavelength unit so need to be changed 
along with the unit.

 X-axis Doppler shift rest wavelength

 Processing range
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 Continuum range used for flux normalisation to unity

 Sigma value in Elements tab

When Apply is pressed and the wavelength unit is changed, a message box will offer 
a choice to apply an appropriate conversion factor from one unit to another. Click OK 
if you want the existing values converted, or click Cancel if you will manually 
corrected the values for the new wavelength unit. 

Graphics Antialiasing – This option controls how lines in the chart are rendered. The 
default option is for antialiasing.

Graphics Line Join method – This option determines how data points are joined up.  
The default option draws a line between each point. The bar step option draws only 
horizontal and vertical lines. This option is useful to see any gaps in the data.

Apply Response Correction on image open – When ticked, profiles are rendered with
the most recent response setting held in the .info.bas file, otherwise response 
correction is not applied, (unless applied within a project).

Apply Scaling options on image open – When ticked, the Y-axis scaling option stored
in info.bas file is applied. If unticked, automatic scaling is applied, (unless scaling is 
applied within a project).

2.2.8 Binning tab
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Active region method – The drop down list provides a choice of how intensity is 
calculated when displaying a profile. The current options are:

 Average – The intensity at a given pixel on the x-axis is the average of values 
in the y-axis (i.e. each column is averaged). The range of y-axis values 
summed can be defined using active binned region (otherwise it will average 
across the height of the image). See the Selection menu. 

 Exceed Background – Similar to the ‘Average’ method but only includes 
values exceeding the average background intensity, assuming a background 
region has been set. 

Background method – The drop down list provides a choice of how background is 
calculated when displaying a profile. The current options are:

 Average with % threshold 
 Exceed Background
 Median

Background threshold % - Percentage used for Background subtraction. Values 
above the threshold are excluded.
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2.2.9 Ranges Tab

2.2.9.1 Processing range

The start & end wavelength processing values are used to restrict the range for 
processing operations such as ‘division’. Without this restriction spurious results 
where the camera response is low could spoil the results otherwise obtained.

2.2.9.2 Continuum range

This range is used to provide the default wavelength range for the Flux Normalisation
screen.

2.2.10 Notes tab

A multiline textbox allows comments to be held against or displayed on the chart.

The text will be formatted using carriage returns entered into the multiline text box.

Use the chart context sensitive menu (right mouse click on the chart) to display the 
notes entered on the chart.
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Elements tab

This tab holds the settings that apply to the Scaled Element Lines annotations.
 
2.2.10.1 Line Sigma

A zero '0' value in this textbox always shows vertical lines when Scaled Element 
Lines are added to a chart.
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A non-zero decimal value draws a Gaussian line having a standard deviation equal to
the sigma value in the chosen wavelength unit.  Below shows Gaussian lines with 
sigma =1 Angstrom.
 

2.2.10.2 Line collision detection

A drop down list is provided to automatically shift Scaled Element Line labels created
in the Elements screen where they are congested and overlap.

The four options are
• None – No attempt to correct overlapping label text.
• X – Move to right only
• Y – Move up only
• XY – Move right or up

Example below shows congested labels around 6650 Angstroms
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The same chart below, but using the 'XY – Move right or up' option

If the congestion is light then manual edit of individual lines can be used to left or 
right justify text to avoid overlap.

If the congestion is heavy then an alternative is to delete the text associated with 
overlapping element lines and replace it with a new “Free Line & Label” type labels 
that allow you to specify exactly there the line and text should be placed.

2.2.10.3 Element Label Mask

This is a free text box allowing configuration of what text is shown after new labels 
are created from the Elements screen.  The mask determines which of the possible 
placeholders are to be shown.
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The mask setting is applied only as new labels are added. It won’t affect labels 
already created. 

The data items in a curly brace {} zero based array correspond to the fields shown 
the list box of the Elements screen above.

The third column {2} is not necessarily ionisation. It depends on the file used.
 
Spaces can be used to separate the fields. Fields can also be separated by line 
breaks using ‘\n’.

Some examples (based on using the AllElements.dat file in Reference sub-folder)

Mask Description Label text
{0} just show wavelength 6382.99
{1} just show element name Ne
{1}[{2}] {0} show Element name, then ion in brackets then 

wavelength
Ne[1] 6382.99 

{1}[{2}] {0} {3} show Element name, then ion in brackets, 
wavelength and relative intensity

Ne[1] 6382.99 120

{1}[{2}]\n{0} Show Element name, then ion in brackets in first 
line. Show wavelength on second line.
\n indicates a carriage return 

Ne[1]
6382.99

2.3 Context Sensitive Chart Menu

Right mouse clicking on the chart area will pop-up the context sensitive chart menu.

 Copy Chart to Clipboard – copies the chart picture to the Windows clipboard 
for pasting into another application.

 Save Chart to file – allows the chart to be saved as a picture file

 Show Legend Here – Displays the legend showing the list of profiles. The 
Legend top left corner is displayed at the last position the mouse was clicked.

 Hide Legend – hides the legend from view
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 Show Notes Here - Displays the notes keyed into the Project Settings screen. 
The notes top left corner is displayed at the last position the mouse was 
clicked.

 Hide Notes – hides the notes from view

 Labels  – Opens the Labels Screen to allow features of the chart to be 
annotated

 Save Project – Prompts user to save project to file.

 Project Chart Settings – open the Chart Settings screen. 

2.4 Profile Properties

The profile properties screen allows control of how the profile is displayed. It is 
organised into separate tabs along the top. This screen is called from context 
sensitive menus and also by double clicking on an image strip.

The buttons at the base of the screen are visible and apply across all the tabs

Previous button – Navigates to the previous profile (when more than one is loaded)

Save button – this updates the BASS image information file (.info.bas) so changes 
are reused for other projects using the same profile. (Changes are otherwise only 
applied to this project).

Remove button – Prompts before removing the current profile (and closes the form)

Next button – Navigates to the next profile (when more than one is loaded)

OK button – this applies the profile changes to the project and closes the form

Apply button - this applies the profile changes to the project, but keeps form open

Close button – closes the form

BASS Project 1.9.9 page 35 of 168



2.4.1 General tab

The sequence and caption values are saved at a project level (i.e. you need to save 
the profile in a project). The Caption is also saved at a profile level, in the BASS 
image information file, (.info.bas) to be the default when opened in other projects) 

Sequence drop down list – allows the order that the profiles are displayed to be 
changed. E.g. setting sequence to “01” will move the associated image strip to the 
top of the image strip list. This is important since the first profile is used for default y-
axis profile scaling and the x-axis span.

Caption textbox – the text entered is displayed in the chart legend. The value initially 
defaults to the image filename.

Filename textbox – a read only textbox showing where the file is physically located. 
Use the adjacent File name button to physically rename the file (and its associated 
info.bas file).

FITS Header button – for FITS images only, the button opens the FITS Header 
screen. This allows FIT header values to be viewed (and edited).

Image Strip Ignores Y axis scaling – This checkbox prevents the image strip display 
from brightening or darkening in sync with y axis scaling. This useful when showing 
profiles above one another while preserving the auto rendered image strip intensities.

In the LH example below, where the setting is turned off on all profiles. The image 
strip brightness and contrast are proportional to y-axis Scaling% and Offset% applied
to the profiles within the chart. 

In the RH example below, where the setting is turned on, the image strip brightness 
and contrast are not affected when y-axis Scaling% and Offset% are changed.
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FITS button - for FITS images only, the button opens the FITS Header screen

BeSS button – for FITS images only, the button opens the BeSS (Be Star Spectra) 
settings screen

2.4.2 Line tab  

The Line setting values are saved at a project level. 

Line Colour –  By default, each image added to the project is automatically allocated 
a colour. The icon allows a profile to use a specific colour.
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Note: Markers are most useful to show pixels when zooming in on a small region of 
interest; otherwise they will just make the line appear thicker.

Note: The profile will be hidden from the chart when [no line marker] is used with 
Line Width =0 and Fill Style = No Fill.

Transparent – The checkbox will make the Fill Style transparent. Does not apply to
“No Fill” or “Solid”
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Line Width – The drop down list allows 
the width of the profile to be set. 

Line Marker – The drop down list 
provides options below to display a 
marker. 

Line Style – The drop down list 
provides line style options. This can 
make it easier to differentiate between 
the profiles when printed in black and 
white.

Fill Style – The drop 
down list provides 
various fill style 
options. 



2.4.3 Y-Axis tab

The ‘Data Multiplier’ and ‘Data Offset’ textboxes allow raw data flux (ADU) values to 
be rescaled. The default values are 0 and 1 respectively.

The ‘Apply to all’ button will copy the Y axis settings to all other loaded profiles

The Normalise Flux button (to the right of the Data Multiplier) opens the Normalise 
Flux screen 
 
This tab provides three main options for scaling the Y-Axis.

• Automatic scaling
• Manual scaling
• Scale as first profile
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2.4.3.1 Automatic scaling 

This is the default option and will automatically scale the profile to fit the range of 
intensity values (within the X-axis region) to the height of the chart.

Y Scaling % - The slider and textbox allow the magnitude of the profile displayed to 
be increased or decreased (i.e. enlarge or reduce the profile). Press Enter after 
editing the textbox to apply.

Y Offset % - The slider and textbox allow the vertical position of the profile to be 
increased or decreased (i.e. move the profile up or down). Press Enter after editing 
the textbox to apply.

The Y Scaling and Y Offset (and associated textboxes) are only enabled when the 
Automatic scaling option is chosen

2.4.3.2 Manual scaling

Scaling will be set using the minimum and maximum (ADU) flux values into the 
textboxes provided. Ensure you enter valid flux values otherwise the profile may not 
be shown.

The textboxes are only enabled if the Manual Scaling option is chosen.

2.4.3.3 Scale as first profile

The profile will use the same the minimum and maximum flux scaling values as the 
first profile. This is useful to compare spectra taken on several sessions with the 
same camera settings.

Note: The default chart Y-axis values are those of the first profile. Subsequent 
profiles added can have their own scaling which can be misleading.  
Use 'Scale as first profile' to use a common scaling. Alternatively, enable a second 
y-axis on the RH side (see y-Axis tab in Chart Settings)..
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2.4.4 Calibration tab

This screen provides various options for selecting which calibration option or 
coefficients to use. For details of creating a calibration and/or to see the calibration 
points, see the Wavelength Calibration section.

The choice of calibration option (the radio button selected) is saved at a project level 
(i.e. you need to save the project to preserve the setting). 

No Calibration – Radio button allows calibration to be turned off. This will remain off 
when processing a DAT file profile that is already calibrated by having wavelength in 
the first column.

Use Calibration from First Profile – Radio button allows the profile to temporarily 
inherit the calibration of the first profile. 

This is useful for when multiple profiles having the same calibration or dispersion are 
added to a chart. This is the default option when uncalibrated profiles are opened 
when the first profile is calibrated.  

Profiles having the same dispersion (but differing offsets) can be manually aligned 
by setting the Image Strip View to ‘Raw Image’ or ‘Synth Binned (raw)’ and moving
the image strips horizontally using the mouse while holding the Shift key.

Aligning or sliding the images will have no effect on the chart unless the Use 
Calibration from First Profile option is selected.

The “Copy” button has been provided to copy the calibration dispersion from the first 
profile and incorporate any offset from manual alignment of the image strips.  Press 
Save to store the calibration. Once the calibration has been copied, the first profile 
can be removed.
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Use Individual Calibration – Radio button to use calibration derived using this 
application. 

The Coefficients textbox allows advanced users to read & access the polynomial 
calibration terms. Clearing the text box will remove calibration. The coefficients are 
saved in the BASS image information(.info.bas) file.

The “Calibrate” button will launch calibration mode. This will start a new calibration or
edit an existing calibration.

Note that the coefficients are stored within the .info.bas file in nanometer units with 
a unit conversion applied where necessary

Use FITS Header values – For FITS images only. Radio button to use the calibration 
values held in the FITS Header (in CRVAL1 & CDELT1 keyword values). This 
currently supports linear FITS calibration tags only.

The read only textbox shows the values from the FITS header.

The BeSS settings screen can be used to populate the FITS header calibration 
values.

Lamda Offset – Textbox allows a manual shift of calibration by the specified negative 
or positive offset in nm. This offset remains in nanometers regardless of the selected 
wavelength unit. 

Note: Changing calibration settings can have adverse effects if the profile has 
instrument response settings (because response curves depend on wavelength).

2.4.5 Response tab

The Response tab provides a choice of options for managing instrument and 
continuum response corrections. 

The choice of correction option (the radio button selected) is saved at a project level 
since this can be project specific. You need to save the project to store this setting.  

The response values in the text boxes are saved in the BASS image information file 
(.info.bas) file.

Note: Response correction settings are only valid for the calibration setting used 
when they were created. Corrections can give erratic results if the calibration is 
removed or altered.
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No Correction – Radio button allows existing correction to be turned off. This can 
remain off when processing a profile that has already had correction applied at the 
source. 

This is the default setting when a profile is added to a project. Remember to select 
one of the options below if correction needs to be applied, or save as a project to 
automatically apply correction when next loaded. 

Response File – Radio button allows the correction to be loaded from a response 
profile DAT file (created by BASS or other software). The adjacent browse offers a 
Windows file dialog to help locate the file. 

If you want to use an instrument response file in FITS format, select ‘No Instrument 
Correction’ and divide your profile with your response file to obtain a new corrected 
profile.

Instrument Correction – Radio button allows the profile to use the instrument 
response correction points created in the Continuum & Response Shaper screen. 

The Points text box provides access to the data points that make up the response 
correction

Continuum Removal - Radio button allows the profile to use the continuum removal 
correction created in the Continuum & Response Shaper screen.

The Points text box provides access to the data points that make up the response 
correction. The adjacent Edit button allows the correction to be modified.

Master ResponseCurves,dat file – Radio button allows the profile to select a 
response correction from the drop down list.
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Named profiles are generated by the Continuum & Response Shaper screen and are
stored in the .\Instruments\ResponseCurves.dat text file which can be edited via the 
Edit button next to the drop down list. 

The text file is in comma separated format. The first column is the name of the 
correction, the remainder being the data points. Editing should be limited to renaming
the first column and/or removing unwanted rows (to minimise the risk of corrupting 
the data points). 

Note: To simultaneously display the uncorrected, corrected and normalised 
versions of a single profile, load the same profile three times and set each to a 
different response correction option.

2.5 Image Strips

The area between the tool bar and the chart will display the image strips loaded, 
including reference spectra (but not Planck curves).

Double clicking on an image strip will load the Profile Properties

Right mouse clicking on an image strip will provide a pop-up menu allowing access to
many other functions.

Image strip pictures can be copied to the clipboard or to an image file using the 
options under the main Chart menu. 

2.5.1 Image Strip View type selection

The image strips work in conjunction with the Image Strip View drop down list 
available on the toolbar. 
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There are nine Image Strip View options:

Raw Image

Shows the raw images in actual 100% size or zoomed at 25%, 50%, 200% or 400%.

Note: Reference spectra and generated one dimensional profiles are shown 
extended to the default image strip height setting (in the Chart Settings screen).

Selecting one of the five Raw Image options also enables the main Image menu and 
sub menus. See the Image processing menu section for details.

Holding the Shift key allows an image to be moved or aligned.

Holding the Control key updates the LH status bar to show pixel X & Y position and 
ADU value.

Synth Binned (raw) 

Shows grey binned (average of vertical binned pixels) image in actual image width.

Synth Colour (raw) 

Shows false colour binned (average of vertical binned pixels) image in actual image 
width.

Note – the displayed colours will be meaningless if the chart is not calibrated

Synth Binned (stretch) 

Shows grey binned (average of vertical binned pixels) image stretched to the width of
the chart.  
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Synth Colour (stretch) 

Shows false binned (average of vertical pixels) image stretched to the width of the 
chart. 

Note – the displayed colours will be meaningless if the chart is not calibrated

The stretch options are the most useful for final presentation since the chart and 
image lines will be synchronised. The other options are useful for alignment and/or 
checking if things are as expected.

2.5.2 Context Sensitive Image Strip Menu

Right mouse clicking on an image strip will show a pop-up menu with options for the 
associated profile.

 Profile # - The first item is not a menu, but displays the profile sequence 
number of the selected profile

 Save Image As – Opens a Save File dialog to save the selected image

 Save as 1D Profile– See section Save As 1D 

 Sequence – Change the sequence (order in image strip view) of the current 
image 

 Hide Profile from Chart – toggle visibility of the profile in the chart. When 
‘hidden’ the profile display properties are set to ‘Line Width=0’ and ‘No 
Marker’. When ‘unhidden’ then ‘Line Width=1’  
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 Remove Image – the icon prompts to remove the current selected image strip 
and associated profile

 Nudge left 1 pixel –  Slides the selected image strip by a single pixel for 
alignment purposes (see next section). This is disabled for the stretch image 
strip options 

 Nudge right 1 pixel – as per Nudge left but in the other direction

 Profile Properties – Open the Profile Properties screen for the selected profile.

 Copy Active Binned Region from – This is used to apply the same active 
binned region from a science image onto a calibration image. Details can be 
found in the BASS Project 1.9.5 Release Notes.

 Region Selection Tool – Shortcut to open the Region Selection Tool.

2.5.3 Manual Alignment of Image profiles

The image strips can be slid in the horizontal direction for manually alignment 
purposes when the shift button is held down. Image strips can also be slid using the 
Nudge left/right option by right clicking on an image strip.

Sliding image strips is applicable to the following scenarios:

 Alignment of a number of profiles prior to stacking
 Alignment of common features for profiles that have the same spectral 

dispersion
 Alignment of a profile with a calibration profile.

The manual alignment can be used in conjunction with the “Use Calibration From 
First Profile’ option (in Calibration tab of the Profile Properties screen) to calibrate 
one profile from another having the same dispersion but a different offset. 

Manual alignment can be reset (removed) by clicking the Reset button in the Stack 
and Align Profiles screen.

Note: Manual alignment is not allowed when a stretch mode option on the Image 
View drop down list is selected. A warning is displayed on the LH status bar

Note: Alignment is limited to single pixels only. It is possible to improve the 
accuracy of alignment by using the 200% or 400% Image View options or first 
resampling images to a larger number of pixels.

2.5.4 Identification of image strips

Hovering the mouse over an image strip will show the sequence number, caption and
file path of the image underneath.
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2.6 Selection menu

The Selection menu is only enabled when a two dimensional image is selected and 
the Image Strip View drop down list is set to a Raw Image option.

2.6.1 Selection regions

The following options act upon on the rectangular area selected using the mouse on 
the current image

 Crop to Selection – crops the image to the current selection. The cropped 
image can be saved using the ‘Save Image As’ menu

 New Image from Selection – adds the selected area as a new image to the 
project. The default filename is <oldFileName> + “_crop”.

 Set active binned region – Binning will average only pixels within the height of 
the selected region. Shortcut access Ctrl + 1.

 Set subtraction region 1 – Defines the height of background region 1 to be 
subtracted from the active binned region. Shortcut access Ctrl + 2.

.
 Set subtraction region 2 – Defines the height of background region 2 to be 

subtracted from the active binned region. Shortcut access Ctrl + 3.
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 Quick active & sub regions – Creates active region based on selection but 
also adds defaults for subtraction regions 1 & 2 which may require subsequent
tuning. Shortcut access Ctrl + 4

 Quick active & sub regions wide – As previous option but with wider spacing of
regions. Shortcut access Ctrl + 5

 Set Exclusion region - This defines a region, shown using light blue lines, 
where rows will be ignored from binning. This may be useful to exclude target 
spectrum contamination from a reference spectrum. Shortcut access Ctrl + 7.

 Clear selections – clears the active, excluded & binned selections/regions 
(and renders the profile using an average of pixels over total image height). 
Shortcut access Ctrl + 0.

Region Selection Tool - Opens the Region Selection Tool screen (see below) 
for fine adjustment of a selected area on an image. Shortcut access Ctrl + 9. 

Any individual region no longer required can be removed using the Region Selection 
Tool.

Changes to regions will take effect when the chart is refreshed (press F5 or click 
Refresh button).

2.6.2 Region Selection Tool

This screen is accessed from the Selection menu or aright click on an image strip. It 
allows finer control of the binning and background regions than using a mouse. It 
also allows individual regions to be removed.
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The screen provides the following features:

 Profile - This is a read only text box that displays the active profile that 
changes will be applied to.

Region Type – A drop down list allowing the type of region 

Changing the Region Type will update the X and Y values. The Generic 
Selection is useful for accurately setting an area prior to image cropping

 X Start – First X pixel of area. 
 X End – Last X pixel of area. 
 Y Start – First Y pixel of area
 Y End – Last Y pixel of area
 Width – a read only field calculated by X End minus X Start
 Height – a read only field calculated by Y End minus Y Start

 Statistics Area - A read only selectable text box that displays the flux statistics 
of the current area defined by the X and Y values

 Copy – A drop down menu provides the following options 

You must have the PythonFileFiles folder installed to run these plot options.
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o Copies the ADU values to the 
Windows clipboard in tab delimited 
format for subsequent analysis (e.g. 
paste into Excel)

o Copies the Statistics to the Windows
clipboard

 Python – A drop down menu provides the 
following options to render the selected 
region using compiled Python scripts. 



Plot2d.py - Runs the two dimensional Python colour map plot passing in the 
selected pixel area. Close the DOS prompt window to return to BASS.

Plot3d.py - Runs the 3 dimensional Python colour plot passing in the 
selected pixel area.

On running, the user is prompted for the altitude and elevation viewpoint for 
the 3D perspective.  You can edit the default values or just press Enter to 
accept.

Close the DOS prompt window to return to BASS
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 Options – a drop down menu 
provides the following options 



o Update main Chart on Save – Updates the main chart to synchronise 
regions when the Save button is pressed
 

o Show Cross Section – Show/hide the RH Profile Cross Section panel

o Use Bar Step for Cross Section – Toggle cross section plot to use 
joined lines or bar steps.

Cross Section Panel – shows the cross section of profile based on current 
selected region. Moving the mouse over the panel will show ADU and pixel 
position. The screen can also be resized.

A vertical slider control on RH side also shows threshold in terms of maximum 
and minimum ADU.

The plot gets updated when a mouse selection is made on the Image Strip. 

 
 Remove – A button that removes values for the selected Region Type

 Save -  The current area defined by X and Y values is saved for the selected 
Region Type

 Close – Closes the screen

The best way to use this screen is to select a Region Type before adjusting the X 
and Y values. The X and Y values can set using the up/down arrow keys and/or 
making a selection on the active image. 
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The Active, Subtraction and Exclusion region types will span the full width. Therefore 
X Start and X End will be read only and set to 0 and full width respectively.  

2.7 Image processing menu

The image processing functionality is for FITS image formats and is available under 
the main ‘Image’ menu.  Sub menu items under the Image menu are enabled or 
disabled depending on the Image Strip View drop down list setting and whether the 
current Image is a two dimensional image, (or a one dimensional profile).

Note that keyboard shortcuts have been provided to make it easier to access the 
commonly used screens than using a touchpad or mouse alone. E.g. Ctrl+Alt+R will
open the Rotate/Tilt Correction screen.

2.7.1 Image Profile number & caption

The first menu item is not an active menu; it just displays the sequence number and 
caption of the active image for information purposes

2.7.2 Profile Properties

This loads the  Profile Properties screen for the active image.

2.7.3 FITS Raw Header 

This opens the  FITS Raw Header screen. (This is also available via the General tab 
of the Profile Properties screen).

This screen allows the FITS header values to be examined or modified. 

Forward and Back buttons allow navigation through loaded images.
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A Find Text textbox allows searches to be made. Enter search text and press Find.

The Enable Edit checkbox allows changes to be made, but displays a warning 
message. 

Warning - Don’t make any changes to the FITS values unless you have a backup 
of your file and understand how FITS keywords should be formatted!

A right mouse click menu allows access to copy, edit, delete & insert options.

Note the FITS file will need to be saved to make changes permanent

2.7.4 BeSS Settings

This opens the BeSS Settings screen
 
2.7.5 Save Image As

Prompts for file name to save the active image

2.7.6 Save As 1D
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The Save As 1D screen can be accessed from the toolbar, File menu and by right 
mouse clicking on an image strip.

The purpose of this screen is to create a one-dimensional profile from a two 
dimensional image.

The detailed functionality is listed below:
 FITS Header values are copied from source to target image where applicable.

 The filename to save the new 1D profile is pre-populated with a default "_1D" 
suffix.

 Automatically populates the FITS header with a linear calibration if the source 
was calibrated. 

 Restricts the profile start and end pixels/wavelength range as specified in the 
x-axis crop screen

 If the source image used a polynomial calibration, the profile is re-sampled 
using a default sampling interval based on the highest dispersion value within 
the specified wavelength range. A manual override checkbox to specify your 
own interval is also provided.

 An option is provided to select linear interpolation (rather than cubic spline) 
when a polynomial calibration was used.

 Calibration keyword values within FITS header will be saved in Angstrom unit 
by default.
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 The screen has an option to display the new 1D profile in the project, (saving 
the effort of having to browse and open it). 

Once created, a one dimensional profile can be saved using the normal 'Save As'. 

2.7.7 Black and white levels

This screen enables the FITS black and white levels to be adjusted and allows ADU 
level to be used for hot and cold pixel removal. 

Changing levels will alter the appearance of the raw image, but won’t affect the 
profile chart since this is automatically scaled. 

The levels are stored to the CBlack & CWhite FITS header values when the image is 
saved, to be re-instated when the image is next loaded.

The black and white levels can be set using the textboxes (press Enter after keying in
a value) and/or using the sliders provided.

CWhite/CBlack - checkbox will set levels using CBlack & CWhite FITS header values
where they exist.

Auto Stretch – button sets the levels based on the min and max detected values.

Show Clipping - checkbox is used to show pixels have have been clipped beyond a 
limit. Hot clipped are green. Cold clipped are blue. It also activates the Hot Pixels and
Cold Pixels buttons.

Apply to All Open Images - checkbox will apply the black and white levels to all open 
images.

BASS Project 1.9.9 page 56 of 168



Simple Cold pixel removal method - Set the Black ADU level to show blue pixels to 
be removed. (You may need to temporarily adjust the white level to improve contrast 
or enlarge the image view). Click Cold Pixels button and confirm to apply changes. 
The histogram will be updated.

Simple Hot pixel removal method –  Set White ADU level to show green pixels to be 
removed. Click Hot Pixels button to confirm and apply changes and update the 
histogram.

Note: Hot and cold pixel removal in this screen uses single threshold should be 
used with caution. There is also a dedicated Cosmic, Hot and Cold pixel removal 
screen that provides more sophisticated techniques. 

2.7.8 Cosmic, Hot & Cold Pixel removal

The Cosmic, Hot & Cold Pixel removal screen allows bad camera pixels and random 
cosmic ray hits to be removed. The menu option is enabled for 2D images only.  Hot 
pixels are usually dealt with by dark subtraction techniques (see Stack Images 
section). This screen allows hot pixel removal when no dark images are available.

Cosmic, hot & cold pixel removal should be prior to any processing that alters the 
position of pixels, (e.g. cropping, rotation, slant or tilt correction). 

The hot pixel removal technique relies on the fact that the hot pixels on a spectral 
image will be in the same location as taken on a “dark” image.  The information can 
then be saved to a 'cosmetic' file that can be reused on a number of images taken 
with the same camera (and temperature and exposure settings). It is also possible to 
remove hot pixels directly without a cosmetic file. 

Bad pixels caused by cosmic rays are random (since they are caused by radiation 
striking the CCD sensor).  Analysis and detection can therefore be carried out on the 
light image itself.

The actual process of removing a bad pixel is to replace its value with the median or 
average value of its neighbours.

The screen has two tabs. The Image tab is used to detect bad pixels and apply 
correction. The Cosmetic File tab is used to save and load cosmetic file containing a 
list of bad pixel positions.

2.7.8.1 Image tab functionality

Open File icon – Button to open a different image to use for the detection of pixels. 
(e.g. load a dark file and use it to remove pixels from the current light image)

B & W Level icon – Button to adjust levels to make bad pixels easier to see.
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Threshold ADU% - slider to set detection threshold as percentage (0 to 100%). The 
tooltip displays the ADU counts when mouse is hovered over.

The direction for detection differs according to the Cold Pixel checkbox status.
Cold pixel = Off –> Start high, move to lower threshold to see hot pixels
Cold pixel = On ->  Start low, move to higher threshold to see cold pixels

Depending on the image, values below 1.0% or above 99.0 % may be required, in 
which case it may be easier to key fractional values into the adjacent textbox (and 
press the Enter key).

Excessive hot pixel detection without Edge detection

 Edge detection ignores main spectrum 

Zoom – Drop down list offering 100%, 200%, 300% or 400% view. Zooming in helps 
to select a region for bad pixels within the spectrum and makes detected bad pixels 
easier to see..
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Region of interest – Checkbox allows the detection of hot pixels to be restricted to 
one or more regions selected using the mouse. This is recommended as its more 
flexible than use a single threshold for the entire image).

Cold   pixels – Checkbox to detect cold pixels when ticked. Turn off for hot pixels

Edge detect – Checkbox to compare pixel with neighbours (Turn off to detect based 
on ADU threshold).

Status bar – the status bar on the bottom of the screen shows the statistics of the 
selected range. This can help identify excessively high or low ADU that are indicative
of bad pixels.

Median Correction – Checkbox to use median values when correcting values. Turn 
off to use average.

Apply to all open images – Checkbox will apply pixel correction to all open images.

Revert – Button to rollback pixel correction

Apply – Button that will apply pixel correction changes for the current selected region.
When the Cosmetic File tab is pressed,the corrections will use the items in the Bad 
Pixel list. 

Add+ - Pressing the Add button will add the bad pixels detected in the current region 
into the bad pixel list on the right of the screen. 

Clear – Pressing the Clear button will remove all items from the Bad pixel list. 
Individual items ticked will be removed if the Delete key is pressed,

Bad Pixel list – Listbox that is populated when Add is pressed to store detected bad 
pixels. The list can also be populated when a cosmetic file is loaded.

Detecting bad pixels in subsequent regions is used to build up the bad pixel list.  This
technique helps prevent false detection of ‘good’ pixels if a single threshold was 
applied to the whole image. The contents of the RH list can be saved as a cosmetic 
file using the Save button in the Cosmetic File tab.

Manually Add Bad pixels
In addition to bad pixel detection methods, bad pixels can also be added to the bad 
pixel list by double clicking on the image. A popup panel will then confirm the X Y 
coordinates and allow them to be edited. Note the X and Y values are separated by a
comma. 
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2.7.8.2 Cosmetic file tab functionality

The Cosmetic File tab is used to save a list of bad pixels in a text file. The format of 
the file is broadly compatible with Christian Buil's ISIS software so a *.lst file, (as well 
as *.txt)  extension is allowed 

The cosmetic file contains four columns
• 'P' indicates a bad pixel (L= bad row or C = bad column)
• X coordinate of pixel
• Y coordinate of pixel
• ADU value of pixel

An example extract is shown below

P 371 708 950.423
P 372 708 1100.77
P 671 182 751.2372
P 672 182 877.7254
P 819 519 488.6667
P 1034 506 569.4341
P 1223 552 705.2795
P 1224 552 778.9944
P 1225 552 712.9644

BASS Project 1.9.9 page 60 of 168



Open Icon – button opens a file dialog to select and load a *.lst or *.txt cosmetic file. 
This will update the screen area with the positions of bad pixels in green. It will also 
populate the bad pixel list on the right hand side of the screen.

Save Icon – button to save the items shown in the bad pixel list as cosmetic file.

Add Bad Colu  mn – button that will prompt for the column index of a bad column

Add Bad Row  – button that will prompt for the row index of a bad row

Apply – button to apply correction using the items in the bad pixel list when Cosmetic 
File tab is selected. (This same button applies detected bad pixels based on 
selection when the Image tab is selected.

2.7.8.3 Bad pixel removal process

The basic bad pixel removal process is as follows:

 Ensure the Image Strip View is set to “Raw Image” 

 Load image spectra into a new BASS Project session.

 Click to select the image loaded that contains bad pixels. This is the profile 
that correction will be applied to. 

 Click on the Image -> Cosmic, Hot & Cold Pixel removal menus to open the 
screen. This load a copy of the active image to be used to detect bad pixels. 

 Optional. Click on the Open Dark File icon to load a different image, such as a 
dark image, to use for detecting bad pixels. 

 Click the Region of Interest checkbox.

 Ensure the Cold Pixels checkbox off (not ticked)

BASS Project 1.9.9 page 61 of 168



 Adjust the threshold slider to detect hot pixels. Detected pixels are highlighted 
using a very small green X. Setting  zoom above 100% helps see isolated bad
pixels. Experiment using the Edge Detect checkbox.

 Fine tune the threshold to avoid false detection of pixels on the spectrum itself.

 To save a cosmetic file, click the Save icon in the Cosmetic file tab. Enter 
filename and select *.lst or *.txt file type.

 If you wish to apply the hot pixel removal to all the open images then tick on 
the “Apply to all open images” check box before clicking Apply.

 Click on the Apply button

To remove hot pixels using a saved cosmetic file

 Open the Cosmetic, Hot & Cold Pixel removal screen

 Click the Cosmetic File tab

 Click on the Open icon in the Cosmetic File panel and select a file. This will 
populate the bad pixel list on the RH side.

 Click on the Apply button

2.7.9 Flip Image

A spectral profile should be displayed such that shorter (blue) wavelengths are on the
left and longer (red) wavelengths are on the right. This function will flip the image as 
required. The child menu provides horizontal, vertical, right and left flip options.

To flip multiple images simultaneously, see the Bulk Image Manipulation screen 
section

2.7.10 Rotate/Tilt image 

This allows an image to be rotated, tilted or have horizontal smile correction in order 
to correct for when the spectrum dispersion direction is not straight and horizontal 
relative to the camera sensor. Enabled for two dimensional images only.

Refer to Appendix C – Rotate/Tilt/Smile/Slant correction for how to identify the 
different types of corrections.
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Note: Care should be taken to align the spectrum with the camera axis in the first 
place to minimise the degree of correction required. This allows the camera to 
capture the data with better resolution and prevents artefacts that can be caused 
by correction.

2.7.10.1 Rotate / Tilt tab

The Rotate function is accessed from the Image menu (for a selected FITs image 
when the Image Strip View has one of the Raw Image options selected).

 
Correction Angle panel – Offers a number of different options to enter or derive the 
correction angle

Angle box – A textbox to allow entry of a known correction angle (in degrees). 
Negative numbers are clockwise, positive numbers anticlockwise. Use the 
spin up/down arrows or arrow keys to alter the angle in 0.1 degree increments

Draw Angle – use the mouse to draw a line along the spectrum corresponding 
to the observed rotation or tilt angle. The Correction Angle is calculated as the 
mouse is released. This is useful for angles greater than approximately 5 
degrees, or where selecting a region would not be appropriate (e.g. on a busy 
slit-less image) 

Select Region – use the mouse to draw a rectangle that encompasses the 
spectra to be corrected. The angle is calculated as the mouse is released. 
Recommended, especially for angles less than 5 degrees

Selection Option panel – this panel offers the choice to rotate the image or apply tilt 
correction.

Rotate Image – select this option to rotate the image by the correction angle. 
Recommended for slit-less spectra.
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Centre of Rotation – leave the X and Y textboxes blank to rotate about the 
centre or specify the rotation point. This applies to rotation only. It has no 
effect on tilt.

Tilt Image – select this option to apply tilt correction by the correction angle. 
Recommended for slit spectra.

Emission – this checkbox is ticked by default ready for emission type spectra or using
a bright line. Turn if off for absorption spectra (or where you are correcting a dark 
feature for an extended target such as the Moon). 

Apply to all open images – when this checkbox is ticked, the Apply button will apply 
the correction to all open images.

Apply – this button performs the rotation of the selected image (or all open images) 
using the angle and centre specified.

Reset – this button reverts the selected image to the previous (pre-rotated) state.

Close – this button closes the form.

Since the tilt angle will probably be unknown, it can be determined by trial and error 
by trying successive values and comparing with a rectangle selected around the 
spectrum. 

Spectrum before rotation

Spectrum after rotation

Note: Geometric corrections such as rotation/tilt/smile can sometimes create some
invalid pixels in one or more corners. In this case you would have to crop the 
image to avoid auto-scaling issues.
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2.7.10.2 Horizontal Smile tab

This tab deals with the situation where the spectrum exhibits horizontal curvature that
tilt or rotation alone cannot correct.

After drawing a rectangle, the smile correction coefficients are shown in the text area 
and applied when the Apply button is pressed.  

The coefficients can be copied and pasted to be applied to subsequent patches of 
images taken with the same setup.

2.7.11 Smile & Slant Correction

This allows a FITS image to be corrected for distortions where the spectral lines are 
curved or slanted relative to the axis of the spectrum. Enabled for 2D images only.  

Smile is a curved distortion caused by misalignment within the optical configuration, 
(especially in Littrow spectrographs) and/or lens aberrations.

Slant is a distortion where the absorption lines are straight but are not perpendicular 
to the axis of the spectrum, (this differs from “tilt” where the spectrum direction is not 
aligned with the camera axis). Slant can also be created by trailing effects when 
using a slit-less configuration. 

2.7.11.1 Automatic Smile & Slant Correction

The automatic option will scan a selected region for pixels having the minimum (or 
maximum) intensities to determine the correction required. 

The correction process is as follows:

1. Open the FITS image to be corrected, ensure the Image Strip View is Raw Image
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2. If necessary, rotate and or crop the image to remove any tilt. 

3. Click the image to select it.

4. Open the Smile and Slant corrector screen form the main Image menu.

5. Using the mouse, select a rectangle around the most defined line.

By default, the ‘Emission’ check box is ticked. Remember to un-tick it if working with 
an absorption type (dark) line. 

6. Set ‘Pixels to Average’ at 3, leave Apply Best Fit as [none].

7. Press the Try button. This will draw a yellow curve that tracks the darkest (or 
brightest) pixels.

8. If the yellow curve is broken, experiment with the Average or select a better area 
on the image.

9. Select a Regression option to draw a red line or smooth curve. The Cubic (3rd 
degree) is normally fine. 

10.When the red line or curve fit looks good, press the Apply button to correct the 
selected image.

11. If the correction is not right, press the Reset button and repeat the process.

12. Only press the Close button when the correction is complete. The screen holds 
the original data until the screen is closed. Press the Reset button first if you wish to 
abort the correction.

Calibration should be performed after any tilt, smile or slant correction (as the 
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offset and dispersion will have been affected). 

2.7.11.2 Manual Slant Correction

The manual option will allow the user to either enter or draw the slant angle. The 
image is then corrected so that the slant angle is made vertical. For clarification, 0 
degrees corresponds to a horizontal line.

1. Open the image to be corrected

Spectrum before slant removal

2. Open the Smile and Slant corrector screen form the main Image menu.

3. Click on the Manual Slant tab header

4. Specify the slant angle

If the slant angle is known
 Select the Enter Slant Angle option
 Key in the slant correction angle (in degrees) into the text box provided and 

press the Try button. (You can also change the angle using the spin up/down 
arrows or the arrow keys)

If the slant angle is unknown
 Select the Draw Slant Angle On Image option
 Use the mouse to draw a box around the feature to use for correction and 

press the Try button
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Spectrum after slant removal

5. If necessary, edit the slant angle (by trial and error) and press the Try button until 
the lines are vertical 

6. Only press the Close button when the correction is complete, or press the 
Reset button first if you wish to abort the correction.

2.7.12 Resize Image screen

This allows a selected two dimensional 
images image to be resized.

The resizing can be done either on a 
percentage basis (for both width and 
height), or by specifying new width and/or
height values.

The 'Apply to all open images' option 
applies the new width and height values 
to all other open images.

2.7.13 Normalise Flux Scale

The main use is for normalising the y-axis continuum value to "1".

The Normalisation Flux Scale screen (accessed from under the Image menu) has 
three tab headings. 

 Normalise Continuum – Uses the average flux over a given wavelength range
 Absolute Flux – Convert flux to energy units 

BASS Project 1.9.9 page 68 of 168



 Advanced – Rescales the y-axis to a target value using upper and lower flux 
values. 

Important – the Y axis chart values are derived from the top (first) displayed profile.
If you perform a flux normalisation, say on profile 2 or 3, then the change may not 
be visible (depending on y-axis profile settings).

2.7.13.1 Normalise Continuum tab

The Normalise Continuum tab will normalise the scale using the average value 
between the specified wavelength range. 

The default range shown is taken from the Ranges tab of Chart Settings, but values 
can be overwritten if necessary.

Click Apply to normalise the flux intensity to 1. 

Note that the average flux between the specified range is populated in the Upper + 
Raw text box in the Advanced tab.
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2.7.13.2 Absolute Flux tab

The Absolute Flux tab provides calculation of flux and scaling in energy units 
(erg/cm2/s/A) at 5556A based on a known visual magnitude.

The Calc Flux button is used to calculate the Absolute flux at 5556 Angstroms using 
the following equation (as used in ISIS software).

Fa = 10 - 0.4 * V - 8.449

Where Fa = absolute flux (erg/cm2/s/A) at 5556A and V= visual magnitude
 
The Absolute Flux value is subsequently used to scale the chart when Apply is 
clicked.

2.7.13.3 Advanced tab

The Advanced tab provides an alternative method for flux normalisation based on 
taking a measurement.
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Follow the instructions provided in the screen shots below.
 

If you want to normalise to a value other than “1”, overwrite “1” with your chosen 
value into Upper Normalised (New) textbox.

Press Reset to revert back to normal ADU scaling.

2.7.14 Edit Profile Flux Values

The Edit Profile Values screen is available under the Image menu and it allows 
profile flux values to be edited for one dimensional FITS profiles only. This 
functionality is intended to remove spurious data, such as from cosmetic or hot pixels
when the original two dimensional image is no longer available. 

This function is not intended for falsification of data!
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The main part of the screen is a data grid containing the following columns
 Pixel – Read only column. Shows the pixel number
 Wavelength – Read only column. Shows the wavelength calculated for the 

given pixel.  This is set to the pixel number if not calibrated
 Original Flux – Read only column. Shows the original (unedited) flux value
 New Flux – Editable column initially populated with original values

Note Scrolling the grid will synchronise the row with the cursor on the chart (so long 
as it is within the display bounds). In addition, clicking on the chart will synchronise 
the row that is displayed in the data grid. You can also zoom in using the X Axis 
crop too to make it easier to identify the pixel to edit.

There are the following buttons on the bottom of the screen
 Interpolate – This button will prompt to replace the New Flux value for the 

selected pixel with an interpolated value using the previous and next original 
values. It is disabled for first and last rows.

 Apply – button will apply changes made and redraw the chart so changes are 
visible.

 Reset – button to undo changes and revert to the original data.

 Close – button to close the screen.

To make changes permanent, don’t forget to save the profile after you have closed 
the screen. 
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2.7.15 Echelle Extraction

The screen is accessed from the Image  menu > Echelle extraction.

An Echelle image typically captures multiple orders of spectra that are very often 
curved. Individual spectra need to be extracted and straightened before they can be 
reduced.

The Echelle processing method  allows 
multiple curved spectral orders to be 
extracted from a target Echelle image 
and its associated reference image in 
one operation.
 
The currently selected target image strip 
will be the target and is displayed on the 
screen caption.
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Counter – A textbox used as the starting counter when naming the extracted orders. 
Default will be 1. You can enter a higher value; say 6, if you had already processed 
the first 5 orders in a previous session.  A non-numeric input is interpreted as zero.

Reference Extract – A drop down list allowing you to select the reference calibration 
image that applies to the target. This creates additional image strips (see Add 
button).

Target Extract – A drop down list allowing you to select the target (science) image. 
This creates additional image strips (see Add button).

Data Grid – A grid showing the Echell orders identified by a rectangle selected using 
the mouse. The grid will scroll and the screen can be resized to show more rows.

The grid columns are:

 # - the order number. This is equal to the row position and the Counter value. 
Read only

 X – centre X pixel value. Read only
 Y – centre Y pixel value Read only
 D – delete icon. Click to remove unwanted row (N.B. This does not remove the

image strip, if already added).
 Add – checkbox. Ticked values create new image strips when the Add button 

underneath is pressed

Clear – button to remove data grid rows.  You will be prompted to save new image 
strips. It will be easier to save multiple images before clearing the grid or closing the 
screen, (the alternative being to save one at a time later).

Add button
Use the Add button to create a set of straightened image strips for every grid row 
having ‘Add’ ticked. Once added, the tick is turned off to prevent duplicates

When a Flat image is used, it must be selected prior to the Echelle screen being 
opened. The Reference Extract is then mapped to the calibration image and the 
Target Extract mapped to the science image. If no Flat image is used, the science 
image is selected prior to  the  Echelle screen being opened.
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Note: Using a flat image has the benefit of being able to extract spectra that don’t 
have a strong continuum. 

Each new image from the target will have a default caption (& filename) consisting of 
<OriginalTargetName>  + ‘_ECH_’ + <#> . Where <#> is an incrementing counter 
that uses the number entered into the textbox.  E.g.  BetaLyr_ECH_04

Each new image from the reference or flat image will use a slightly different naming 
<OriginalTargetName>  + ‘_ECH_REF_’ + <#>  E.g.  BetaLyr_ECH_REF_04

Save button
The Save button is enabled after one or more orders have been extracted. It is used 
to save all new image strips to disc in the same location as the target image. The file 
naming convention will be as stated above.

Close – button to exit screen.  You will be prompted to save new image strips (as per
Clear button).

The photo below shows an extract of three spectral orders where flat and reference 
images were provided. 

Please refer to the Echelle tutorial document link below for more details, but note that
the it was written before the ability to use flat echelle images was added.
https://www.dropbox.com/s/28hh659jkff3wb2/BASS%20Echelle%20Processing
%200_4.pdf?dl=0
 

2.7.16 Bulk Image Manipulation screen

This allows image processing and manipulation to be applied to multiple images. For 
example, all images can be flipped from left to right and be set to the same active 
and background regions, and/or black and white levels.  This functionality is intended 
primarily for a small number of slit spectrometer images that don’t require alignment. 
Enabled for 2D images only.

It is recommended that you are familiar with executing image processing on 
individual images before processing images in bulk.  In addition, the processing 
applied to multiple images must be appropriate e.g. the images should be of the 
same target and configuration
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Note: There is a finite limit on the number of images that can be processed before 
you see ‘out of memory’ error messages. Large DSLR or CCD images may need 
to be cropped or processed in smaller batches. 

The screen contains the following features

 Active and Background Regions - ticking this checkbox will copy active and 
background region settings from the top image to all open images.

 Black and White levels – ticking this checkbox will apply the black and white 
levels from the top image to all open profiles

 Crop to Selection – this will crop all open images using the current selected 
rectangle on the top image.

 Flip Left to Right – this will flip all open images from left to right (mirror image).

 Save Images As – this will save all images within the project with a new 
filename constructed using a prefix in front of the original filename. 

This is useful when you need to save separate copies of file, say that had 
been cropped and/or rotated etc. The project is immediately updated to use 
the new filenames.

New images must be saved beforehand. Any prefixed filename that already 
exists will be overwritten without warning.
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Note. Take care not to run multiple times as the filenames will also be 
prefixed multiple times and you will get more versions. If you need to redo, it
may be better to close the project and reload the original images. 

 Maths Operation –. Allows a two dimensional maths operation (e.g. divide all 
open images by one flat image), so long as all images are the same size. 
Useful for applying a flat for Spectro-Heliograms. Do not confuse this with the 
existing one dimensional maths operations function that acts on profiles
 

 Reset – button to undo changes applied when Apply was pressed

 Apply – button to apply changes to all open images

 Close – close the screen

Note that Crop to Selection cannot be used at the same time as Active and 
Background Regions. Crop the images before setting active and background regions.

2.8 Stack Images

A Stack Images screen is provided to provide stacking and alignment of images to 
improve the signal to noise ratio. (Not to be confused with functionality for stacking 
and alignment of one dimensional profiles). 
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The Stack Images screen is accessed via a toolbar icon 
or the  main File menu.



2.8.1 File Menu

2.8.2 Image Menu

2.8.3 Zoom Menu

2.8.4 Light Images tab

The first tab header allows the light images to be loaded for stacking.
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The Stack Images File menu includes 
the following options.

This allows the list of files and settings to
be saved and loaded.  A default file 
extension of “*.stk” is used. The file 
format is tab delimited text.

The Image menu provides a Black & 
White Levels option

The Zoom menu is only enabled when an
image in a list box is selected. 

The zoom options allow the selected 
image to be viewed at a different scale.



 

To load images press the Folder button and select one or more files from a Windows 
file dialog.

Clicking on a file from the LH list box displays the image on the right as well as info. 
In the LH status bar.

To remove images files, highlight one or more files in the list box and press the 
Remove button

Note – If the Shift key is held down when the Remove button is pressed then an 
option will appear allowing the actual files (and associated BASS image 
information file *.info.bas files) to be deleted.

Where possible, local files are moved to the PC Recycle Bin, (but will not be 
recoverable if the recycle bin is disabled, full or if the files are on a network drive).  

Selecting each file item in the list in turn, allows a basic examination of each file with 
an end to rejecting lower quality images.  If necessary, use the black and white levels
icon (next to the Stack button) to make images easier to view.

2.8.5 Image Alignment

An alignment option drop down list is provided. 
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The options are:
 No alignment – images are stacked without any alignment. (Normal for slit-

spectrometer spectral images).

 Align images – aligns images in horizontal and vertical directions. This is the 
default option

 Align horizontal only* – images are only aligned in the horizontal direction

 Align vertical only* – images are only aligned in the vertical direction

* Experimental settings for spectral processing only

If alignment is required, select the first image in the list of light images and then 
select a rectangle around a feature to be used for alignment (the ‘Zero Order’ 
normally works well enough for a slit-less grating image).  The selection should be of 
sufficient size to encompass the same feature in subsequent images. If this is not 
possible, because other brighter features would be picked up, then individual 
selections of the feature can be specified per image.

To remove alignment information, click the ‘Clear align points’ button.

Note: If alignment is necessary but cannot be achieved due to a lack of point 
features, then another possibility is to process frames individually and use the 
Stack and Align Profiles functionality under the Operations main menu.

If Dark, Bias, Flat and or Flat Dark images were taken, click on the second tab 
header and load (see next section).

Note – A globular cluster image is shown in this example, but the images could also
be from a slit-less Star Analyser type grating or a slit spectrometer.
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2.8.6 Other Images tab

The second tab header provides sections on left hand side to allow Dark, Bias, Flat 
and/or Flat Dark images to be loaded or removed. Selecting a file from a list box 
displays the image on the right.
 

To load files press the Folder button and select one or more from a Windows file 
dialog.

To remove files, highlight one or more files and press the Remove button

Note – If the Shift key is held down when the Remove button is pressed then an 
option will appear allowing the actual files (and *.info.bas files) to be deleted. 

Files in the second tab are not mandatory. Where multiple files are provided, the 
system will generate a ‘master’ on the fly that has data combined by median or 
arithmetic mean (defined in the first tab header).

The Cosmetic File section allows a single cosmetic file, (see Cosmetic, Hot & Cold 
pixel section), to be loaded. The Cosmetic file will be applied to all images specified 
in Light and Other Images tabs.

Dark Image Scale Factor
Scaling of dark image frames allowing pre-processing to use dark frame images 
having exposure times not equal to light exposures, so long as dark and bias images 
are provides and EXPTIME is populated in the FITS header.  If no EXPTIME 
keyword exists in the FITS header (e.g. if frames are RGB files such as jpeg), a 
textbox is provided to enter a manual light/dark exposure scaling factor. 
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For example if your light images have a 60 second exposure but your dark images 
are 40 second, you enter a factor of (60/40) = 1.5.

When a value > 0 is entered into the dark scale factor checkbox, you are prompted 
before stacking is run, to confirm if the calculated or manual scaling value should be 
used. 

 Yes – use the manually input factor (1.5 in example above)
 No – use the calculated value based on FITS header (e.g. 1.333)
 Cancel - abort without stacking

The tooltip information in the screenshot below provides a reminder of the purpose of
the textbox. 

2.8.7 Stacking Process 

Pressing the Stack button will initiate processing as follows:

1. Validate that one or more Light images are loaded
2. Validate that an alignment region is set for at least the first image (only if an 

Align Images option is selected)
3. Apply cosmetic file (if exists) to all Dark, Bias, Flat and/or FlatDark images. 
4. Aggregate Dark images (if exist)
5. Aggregate Bias images (if exist)
6. Aggregate Flat images (if exist) and normalise to nominal 1 if option ticked.
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7. Aggregate Flat Dark images (if exist)
8. Each Light image frame is then processed to:

a. Apply cosmetic file (if exists)
b. Subtract the master Bias value from the Light value (if Bias frames 

exist)
c. Subtract the master Dark value (if exist) minus the Bias value (if bias 

frames exist). This allows for scaled darks that have an exposure time 
that differs from the Light images. If exposure times match then Bias 
subtractions cancel out. 

d. Divide by the master Flat value minus the Flat Dark master value (if 
exist) or the Bias value. 

e. The pixel position is adjusted such that Light frame values are stacked 
accordingly (if alignment enabled).

9. The result creates a new FITS image that is loaded into the main BASS 
Project chart for subsequent background removal, calibration etc. Set the 
Image Strip View to raw image to see the stacked result.

10.The FITS header keywords, DATE-OBS, DATE-END and EXPTIME, are 
populated to show the start and end date & times of image acquisition. 
EXPTIME shows the time in seconds, between the end of the last image and 
the start of the first (not the camera exposure time).

11.A comment is added to the FITS header that shows the number of image 
frames used

Note: A Flat Dark frame is a dark frame that is taken with the same exposure time 
used to capture the Flat frames. The Flat Dark takes precedence over the Bias. 
This means the Flat Dark is subtracted from the Flat. The Bias is then only used 
with the Light and Dark frames. 

You can open the Stack Images screen again to review and restack if necessary. 
Notice that there will be yellow “+” at each detected alignment point. 
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Note: The Stacking mechanism is intended for spectroscopic use. It therefore does 
not provide astronomical image processing functionality such as curves and 
layering. 

In addition, there is an assumption that only a relatively small number of images will 
be stacked (up to 50 depending on image size).

2.9 Stack and Align Profiles

Stacking profiles averages a set of one dimensional image profiles to create an 
average of the profiles, usually in order to improve the signal to noise ratio.

See also the Stack Images section to stack and align two dimensional images. 

The Stack and Align profiles screen, accessible from the Operations menu, allows 
one dimensional profiles to be stacked, aligned or aligned and stacked.

Here is a high level process to align & stack multiple profiles
 

 Load multiple spectra (10 in this case). These were unguided so positions of 
spectral lines vary in each spectrum. 

 Before aligning & stacking you would need to apply geometric (corrections if 
required) and the set the binning and background subtracted regions of each 
profile. This can be done using the Region Selection Tool  and Bulk Image 
Manipulation screen functions. 
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 Open the Stack and Align screen from the Operation menu

 The Stack and Align screen provides a list box to allow individual profiles to be
selected. All are selected by default. Remember to unselect any you don’t 
want to be included.

NB it is recommended that you reopen this screen if profiles are added or removed
while this screen is open, otherwise the list of profiles may not be up to date.

 Tick the Align checkbox and then either manually key in or use the mouse on 
the chart to select a pixel range on the chart that covers the feature to be 
aligned. In this example we are using the Hydrogen Alpha peaks between 897 
and 960 pixels.

 Tick the Stack and Highlight checkboxes.

 Press the OK button and then OK in the confirmation dialog box. The screen 
will close, profiles will be aligned and a new stacked profile #11 is created.

The format of new profiles created will be either FIT or DAT depending on the format 
of the first selected profile.
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2.10 Stitch Profiles

The Stitch Two Profiles screen is accessed via the “Operation” -> “Stitch one profile 
to another” menu and will allow two or more profiles to be stitched (joined) together to
create a single profile having wider wavelength coverage.

The stitching will work on calibrated and un-calibrated source profiles.  The basic 
principle is to stitch together profiles one at a time from left to right. 

The screen provides the following functionality 

Left Profile – A drop down list of loaded profiles.  Use this to select the first profile to 
stitch. The Left profile should have shorter wavelengths that the Right.

Right Profile – A drop down list of loaded profiles.  Use this to select the second 
profile to stitch. The Right profile should have longer wavelengths that the Left. 

Interval – The sampling interval of the stitched result. The default value is taken from 
the Left profile or will be “1” if not calibrated.
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Overlap Start – The start wavelength (or pixel if not calibrated) of the overlap. This 
defaults to the starting wavelength of the Right profile. It can be beneficial to restrict 
the Overlap Start and Overlap End range to a small flat region. 

Overlap End  – The end wavelength (or pixel if not calibrated)of the overlap. This 
defaults to the end wavelength of the Left profile.

Blend Overlap – A checkbox. When ticked will average the Left & Right profile values
between Overlap Start and Overlap End.  

Normalise Join – A checkbox. When ticked will scale the flux of the Right profile to 
match that of the Left, at the Overlap Start position. Turn this off is you have already 
normalised the scaling.

Result is Top profile – A checkbox. When ticked will promote the stitched profile to be
the top profile. This will cause the chart scale to include the full wavelength span of 
the Left & Right profiles. The stitched profile can be selected as the Left profile to be 
joined to another Right profile having an even longer wavelength start range.

OK – A button to stitch the Left and Right profiles together uses the above settings.  
The caption of each new stitched profile will be Stitch 01, Stitch 02 etc.

Use ‘Save As 1D’ to preserve calibration information when saving the new profile. 

Cancel – A button to close the form.

The checkbox options are all “on” by default and should work well for most scenarios.

2.11 Crop X-Axis Range

This function is available from the toolbar  or Chart menu.

This allows you to zoom in on a region by setting the start and end x-axis display 
values. This is a very important feature since the chart will auto-scale the y-axis 
based on the x-axis range, (y-axis scaling can also be manually adjusted if 
necessary).
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For clarification, this feature only affects the range of pixels or wavelengths 
displayed; it does not permanently ‘crop’ the profile.

 
The three radio buttons offer the choice of cropping using wavelength, pixels and for 
cancelling crop to show the entire profile.

The wavelength radio button and min max boxes will only be available (enabled) 
when the top profile is calibrated

2.11.1 Zoom in

To zoom in on a region within the existing chart, first select the range using the 
mouse, holding down the left mouse button, before clicking on the Crop X-axis icon.

 
The Min and Max values are pre-populated using the range selected prior to clicking 
the icon. Once the screen is displayed, you can edit the text boxes if necessary, 
before clicking on OK or Apply.

The entire chart area is then filled with the cropped region.

You can continue to make selections and zoom in further.
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The textboxes are validated to restrict inputs to the maximum or minimum allowed 
pixel or wavelength values. E.g. if the image is 1391 pixels wide and you try to enter 
9999 then 1391 will be displayed.

2.11.2 Zoom out

To zoom out again either click on the Turn Off Cropping radio button, or specify wider
Min and Max wavelength or pixel values.

2.12 Wavelength Calibration

Wavelength calibration (also known as spectral calibration) is the process to allow 
the profile to be presented using wavelength along the x-axis (rather than pixel).  It 
normally involves identifying two or more features where the wavelength is known.

Note:  BASS uses nanometers (nm) as the default unit of wavelength, but this can 
be easily changed to Angstroms or microns (in Chart Settings see 2.2.7).

The conversion is 1nm = 10 Angstroms = 0.001microns

The functionality to calibrate a spectral profile is accessed by the main Calibration 
menu. Calibration data is saved to the “.info.bas” image information file that shadows 
the profile or image being calibrated. This is able to store multiple order calibrations 
as well as the actual calibration data points (which are not normally stored in FITS 
files). 

The screen functionality is shown in the annotated screen image and described 
below.
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Select element filter - A drop down list containing a list of elements contained in the 
calibration data file. The data is read from the LandaData.dat file in the \Reference 
sub-folder of the installation folder.

Element Sort - A drop down list next to the element filter that changes the sort order 
of the element filter drop down.  

Browse Calibration File - A button to select which calibration data file to use. The 
default file CalibLines.dat (in the \Reference folder under the installation path), 
contains lines most commonly used for calibration, (Hydrogen, Neon, Argon, H20 & 
Mercury).  A LamdaData,dat file is provided (same path) that includes more elements
(e.g. Iron, Silicon, Sodium etc.).

You can create your own calibration data file so long as it is in the comma separated 
value (CSV) text format shown below.

The column definitions are

Element Name String to display in filter drop down
Element Symbol String to display in filter drop down
Wavelength Numeric wavelength (must be in nanometers)
Intensity Optional intensity value (only used for scaled element 

lines – See Labels screen)
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Example extract
without intensity column

Example extract 
Including intensity column

Hydrogen,Hη,383.5384
Hydrogen,Hθ,397.0072
Mercury,Hg,435.833
Mercury,Hg,546.074
Mercury,Hg,576.960
Mercury,Hg,578.966

Hg,3,521.082,30
Th,1,521.123,50
Sc,1,521.128,45
Rh,1,521.152,16
Yb,1,521.16,85
La,1,521.186,720

Do not modify CalibLines.dat or LamdaData,dat files. Edit your own copy instead.

Enter Wavelength - A drop down list that contains the list of element lines. These are 
filtered to a single element if selected from the element filter. You can select from the 
list or key in the wavelength.

Note: Calibration data points can be temporarily disabled by making the pixel value 
negative (by inserting a “–“ e.g. “123.45” to “-123.45”).

Suggest - This button is only enabled once two or more points have been set. When 
pressed, the system will try each of the items in element lines drop down list and 
offer the one having the lowest error as the default selection. This is helpful when 
calibrating an Argon or Neon calibration/reference profile.

This method is not fool proof. 
 It depends on the accuracy of the existing points
 Special care and or additional points are required if the dispersion is non-

linear (e.g. a prism spectrum).
 The ‘true’ element line cannot be suggested unless it is included in the 

element line drop down list.  
 
Barycentre - For advanced use.  A check box to use the barycentre, (centre of mass),
to derive the element line position. The result is very sensitive to the start and end 
selection so it may be beneficial to zoom in and/or increase the chart size.

Barycentre is also an option in the Measurements screen. This allows you to practice
without doing a calibration.

Data Grid - Each calibration point is represented by a row in the data grid. The 
columns are described below.

Column Description
Line The sequence starting at 1 of the calibration points. Read only
Pixel The pixel where the line was selected on the chart. Editable
Wavelength The wavelength (in Angstrom, nm or micron) specified at the 

pixel. The cell value in the last row is synchronised with the value 
from the wavelength combo box. Editable
Setting a wavelength negative will temporarily disable the row.

Error The difference between the calculated fit and the entered value. 
Read only

D (Delete Bin) Clicking the Bin icon will prompt to delete the calibration point
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The Screen can be resized to show more rows if necessary

Calibration fit - This drop down list offers a choice of the degree of polynomial 
required to calculate the fit. When 2 points are taken the only option will be for a 
linear fit. The list will offer 1-n items, where n is the number of points, but limited to a 
maximum of 10. The default choice will be a linear fit.  Generally speaking, look for 
the lowest error values as you change the degree of polynomial.

Hint: Use the up and down arrow keys to change the degree of the polynomial as 
this allows you to see the error values as the degree changes without having to 
open and close the combo box.

Calibration Data Export - The data export button generates a tab delimited text file 
with an *.xls extension and prompts for a filename and path to save.  Once saved, 
the user is prompted to launch file using the application associated with the saved file
extension. This has been tested with Excel and OpenOffice.

The calibration data can be used for subsequent analysis using a 
spreadsheet/workbook. See Appendix A – Calibration Export data file for details of 
the file content.

Total Error text box - This read only text box shows the total error on the points 
entered. This is calculated as the square root of the sum of each error.

Total RMS and calibration point errors are in the chosen wavelength unit.

Coefficients  - This read only text box shows the coefficients derived from the pixel 
and wavelength pairs of values. These are always in nm to maintain backwards 
compatibility when stored in *.info.bas files.

Each coefficient is separated with a comma. The number of coefficients depends on 
the degree of polynomial used. The first value is the offset.

For example a linear fit will have two terms, a and b, corresponding to the offset and 
slope f(x) = a + bx

Note: New and/or non-mathematical users need not be intimidated by 
‘polynomials’ and ‘coefficients’. These values are fully managed within the 
application but are made available for advanced users.

2.12.1 New Calibration 

The Create/Edit Calibration function (available from the main Calibration menu) is 
used to calibrate a new image or to modify the calibration on an already calibrated 
image.

If an existing calibration just needs to be disabled, select the No Calibration option 
from the Calibration tab of the Profile Properties screen. If calibration data needs to 
be permanently removed, use the Remove Calibration option under the Calibration 
menu.
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Any new image created, (e.g. 
by a maths operation, 
stacking, cropping or 
resampling etc.), must be 
saved before it can be 
calibrated.

2.12.1.1 2 Point calibration

The simplest calibration needs just two reference points and uses a linear best fit line
to calculate the wavelength at any pixel position.

Open an uncalibrated spectral image of a star having known absorption lines, then 
select New Calibration. The cursor and the status bar text will turn red to indicate 
calibration mode. Notice the red circle that will track the profile as the mouse is 
moved.

The next step is to identify features and record wavelengths against the features on 
the chart. There are two ways to identify a feature for calibration purposes

 Select a range of pixels either side of the feature, or
 Double click on the minimum or maximum intensity of a feature.

 
In the following examples, the zero order peak on the left will be used as the first 
calibration point.

Selecting the calibration point using a range

This is the default option (where the Shift key is NOT held down) and is 
recommended for most situations.  The LH status bar displays a prompt to Press 
Shift or Select a range either side of the calibration point number (starting from #1)

Click to the left of the first peak and while holding the left mouse button, drag the 
mouse to the other side of the peak. Releasing the mouse will show the location of 
the minimum or maximum peak and open the Calibration Reference Line dialog box. 
This dialog allows you to select from a list of common element lines or manually 
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specify the wavelength.  Enter 0 in the wavelength field or select the Zero Order 
option and press OK. 

Selecting the calibration point using double click

When the Shift key is held down, the LH status bar displays a prompt to double click 
and the current calibration point (starting from #1). The cursor pixel position is also 
displayed.

While holding the Shift key, place the cursor in the centre of the zero order peak and 
double click.  This opens the Calibration Reference Line dialog box allowing you to 
select from a list of common element lines or manually specify the wavelength.  Enter
0 in the wavelength field or select the Zero Order option and press OK.

Adding a second calibration point
Once OK is pressed to accept the first point in the Calibration Reference Line dialog, 
the status bar will prompt for the Second calibration point. Identify the second 
reference line to open the Identify Calibration Reference Line dialog.

For this example, we select the Hydrogen Beta line as the second reference line.  
The dialog box can be moved if it obscures the area of interest. 
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Click on the Select element drop down combo to select the element (Hydrogen in this
case) and then select the Hydrogen Beta option from the reference wavelength 
combo underneath. 

Press “Finish” to complete the two point calibration. The chart X-axis now displays 
wavelength. The status bar (bottom left) will shows the current wavelength when the 
cursor is moved across the chart.

The calibration lines are visible after a calibration is completed. Use the Show 
Calibration item under the main Calibration menu to toggle the lines on/off.

Press “Finish” to complete the 2 point calibration. The chart X-axis now displays 
wavelength. The status bar (bottom left) will shows the current wavelength when the 
cursor is moved across the chart.
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The calibration lines are visible after a calibration is completed. Use the Show 
Calibration item under the main Calibration menu to toggle the lines on/off.

Note: Increasing the working size of the chart prior to calibration can allow a more 
accurate setting of calibration points when using the Double Click method.  Chart 
size is set via the Edit Project Cha

rt settings option under the main Chart menu. 

Note: The calibration points and the calibration equation coefficients are saved into 
the profile’s “.info.bas” image information file.  The calibration equation ‘coefficients’ 
are visible in the Calibration tab of the Profile Properties screen.

2.12.1.2 Single-point calibration

A single point calibration can be used when the linear dispersion is already 
accurately known.

First calibrate a feature on the chart where the wavelength is known, (Hydrogen 
Alpha in the example below).
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Next press the ‘Finish 1Pt’ 
button and key in the dispersion 
factor (in your chosen 
wavelength unit per pixel) into 
the pop-up box provided. 

2.12.1.3 Multiple-point calibration

A multiple point calibration uses three or more points to calculate a polynomial best fit
curve that is used to translate pixel position to wavelength. The reader should be 
familiar with the techniques used in a 2-point calibration before proceeding.

The process is similar to the 2-point calibration except that the “Add Another Point” 
button is clicked when the second point is being set. The ‘Add Another’ button 
accepts the second wavelength and prompts you to identify the third wavelength. 
You can repeat the process to keep on adding more calibration points until the 
“Finish” button is clicked.

 
2.12.2 Edit Calibration

An existing calibration can be edited for calibration points to be added (or removed) 
and/or the degree of polynomial regression to be changed.
 
With a calibrated profile loaded, select the Create/Edit Calibration item from the main 
calibration menu. This opens the ‘Calibration Reference Line’ dialog in the state that 
it was previously in, just before the calibration was completed.

The options available are:
 Edit the wavelength of the last calibration point
 Press Add Another Point to add more calibration points
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 Delete one or more rows from the grid
 Edit values in pixel or wavelength columns (double click or press F2)
 Change the Calibration fit (degree of polynomial)
 Export calibration data for analysis

 
When a calibration edit is in progress the existing calibration and instrument 
response are disabled so the profile returns to its raw state. This will revert back if the
calibration is cancelled. 

2.12.3 Remove Calibration

This menu option will prompt for calibration data, (data points and polynomial 
coefficients), to be removed from the selected profile. Calibration data in the 
*.info.bas file will also be blanked. 

Note: This only removes calibration from profiles calibrated within this application. 
This will not affect DAT files where wavelength is already stored as the first field 
within a profile. It will also not remove any calibration held within a FITS header 
(these can be blanked out using the BeSS Settings screen

2.12.4 Show/Hide Calibration Points

The menu option will toggle the display of calibration points (of the top profile). 

Each calibration label shows the following
 ‘cal’ + sequence number that the point was added
 Wavelength (in Angstrom, nm or micron as setup in Chart Settings)
 Pixel Position

Calibration lines and labels are always shown in red.
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2.12.5 Use Minimal Calibration Text

The menu option will provide an alternative minimal view of the calibration points just 
showing the wavelength. In addition, this option staggers the position of the labels to 
avoid overlaps when lines are congested.

2.12.6 Using Reference lamps

A reference lamp can be used to provide the reference wavelengths for calibration. 
 The reference lamp spectrum should be positioned at the top image strip 

(sequence number 01) in the project with target image(s) loaded beneath.
 Apply tilt, smile and/or slant corrections as required, but ensure the “Apply to 

all” option is ticked so that the reference and target images get the same 
correction applied.

 Calibrate the reference image using the known lines. 
 Copy the calibration from the reference to the target spectra.

2.13 Measurements & Elements screen

The Measurements & Elements screen, (accessed via the toolbar icon  or main 
Tools menu), can be used display measurements and statistics based on a range 
selected on the active profile. This screen also allows lines from elements to be 
added to the chart.

The screen is divided up into four tab header sections

 Elements Lines
 Measurement Options
 Measurement Results
 Python

To take a ‘measurement’, select a range on the chart (after the Measurements & 
Elements screen is opened).  The selected range is shown using a bold/thicker line.
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2.13.1 Element Lines tab

The Element Lines tab is displayed by default when the screen is invoked with a 
calibrated chart. This functionality is not available unless the chart is calibrated. 

When a measurement is taken, the application will search within the min or max 
wavelength against a list of element lines. The closest match, within a specified 
tolerance, is highlighted in the list box1. If one of the ‘Line Type’ options is selected, 
and the Shift key is held while the mouse makes a selection, then a line is 
automatically added to the chart.  

1It is important to understand that the tool to search and identify a single element 
line is just indicative. It extremely sensitive to calibration errors so should be used 
with caution. 

While results can be useful with a small data source file restricted to the main Solar 
lines, it can be misleading when used with a large data source because there can 
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be hundreds of possible element matches even within a small tolerance. 

Data Source - The default data source for the element lines is currently maintained in
the small text file, LamdaData.dat, found in the \Reference folder under the 
installation path (the same file can be used for calibration). This file contains only the 
common element lines (based mainly on the Solar Fraunhofer lines)

Alternative data source files can be used so long as they are placed in the same 
location and are in the same comma separated format with the following fields

 Element Name
 Element Symbol
 Wavelength (in Angstrom, nm or micron)
 (Optional) Intensity2

2 Elements data files having an additional ‘intensity’ column populated are also 
supported. This intensity value is used to scale reference lines relative to one 
another, per element.

Element Lines - The Elements Lines list box shows the element lines from the data 
source and element filter selections.

Element Filter - The element filter drop down list offers a selection of elements that 
are contained in the data source file. [none] will search across all elements in the file.

The filter selection will update the element lines in the element lines list box.

Tolerance - The Tolerance drop down list determines how precise the match needs 
to be. This will depend on many factors including the spectrometer configuration. Use
higher values for low resolution spectra, e.g. try 1 or 2 nm (100 to 200A) with a Star 
Analyser 100.

Colour - The Colour picker allows choice of the colour for element lines subsequently
added.
 
Element display actions 

The Element display options drop down list performs two functions:
 Determines if and how a matching element will be displayed on the chart after 

a measurement
 Allows the user to manually add element lines (independently of the 

measurement).

The Add lines drop down list provides three options
 Show element lines only – a  dotted line without text is displayed
 Show element lines + text – a dotted line plus element symbol and wavelength

are displayed.
 Add to Labels Screen – adds the line in a format where it can be managed 

using the Labels screen

Add - This button will add element lines to the chart as specified in the drop down list.

Clear - The Clear button will remove labels of the same type specified by Line Type
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2.13.2 Manually adding element lines

This allows known spectral lines of elements to be superimposed onto a chart 
(typically in order to see if they correspond with unknown lines from your spectrum).

This is best illustrated with a simple example to display the Hydrogen Balmer lines.

With the Measurements & Elements screen displayed:

 Select LamdaData.Dat as the data source 

 Select Hydrogen from the Element Filter drop down list

 Click the Select/unselect checkbox to select all lines (or select individual 
items).

 Select Scaled lines from the Line Type drop down list.

 Select Vertical from the Text drop down list

 Press Add button

Note The lines added can be individually modified from the the Labels screen  2.26.2.

2.13.3 Measurements Options 

This tab determines which measurements & statistics will be displayed in the 
Measurement Results tab when a measurement is taken. The unit for all intensity 
measurements will be ADU.
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There are two ways to take a measurement:
 Select a region on the chart using the mouse (click and hold left mouse button 

to start, drag to the end and then release). 
 Key in ‘From’ and ‘To’ measurement range and press the Run button

Result Options – This panel provides check boxes to choose what data will be 
returned

• Selection Details
o Selected start, end & width in pixels, wavelength if calibrated and 

velocity if the X-axis is in Doppler Shift mode.

• Statistics (min, max, SNR)
o Max and Min Flux - and the corresponding pixels, (wavelengths if 

calibrated and velocities if the X-axis is in Doppler Shift mode) 
o Flux Range  (Max – Min intensity)
o Average Flux –RMS Intensity   (as root mean square of the 1-

dimensional profile intensity)
o Average and root mean square (RMS) flux values  
o Standard Deviation 
o Signal to Noise Ratio (SNR) as Average Flux / Standard Deviation

Note: Doppler Shift mode is enabled via the X-axis tab of the Chart 
Settings screen.

• Continuum Slope
o Slope of the intensity continuum from selection start to end. Displays 

ADU per wavelength unit (where calibrated) and ADU/pixel

• Equivalent Width 
o Profile Area (area under line)
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o Line Area (area excluding continuum). Also shown as percent of profile 
area

o Continuum Area. The area of line between start and end points and 
zero flux

o Equivalent Width (EW)

EW is a measure of the area of the line on a plot of intensity versus 
wavelength and provides an indication of the power of the line. 

The EW area is shown as a hatched rectangle and is not indicative unless 
the chart y-axis starts at zero or less and the rectangle fits within the x-axis
bounds. 

For emission lines, the EW will be negative.

• FWHM 
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o Full width half maximum in chosen wavelength unit (or pixels if not 
calibrated). This uses a graphical calculation method (to distinguish 
from a Gaussian fit method).

o If calibrated, the calculated R (resolving power = Wavelength / FWHM) 
is also displayed. 
Note the R value assumes the measured line is from a reference lamp 
or similar. Since this value is mostly used for indicative purposes, it will 
be rounded to the nearest whole value.

• Barycentre

This displays a vertical line to show the barycentre (centre of mass) of the 
selected region

• Gaussian 

This checkbox will draw a Gaussian curve within the start and end 
selection range and include standard deviation, FWHM and mean in the 
results.  Fitting the curve is a manual  process. Experiment with the 
selection to get the best fit.
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Report Type – Drop down list determines the output format of the results and also if 
only the active profile, or all the profiles, will be simultaneously measured. The 
options are described in the Measurement Results tab.

Measurement Range - The ‘from’ and ‘to’ text boxes are populated when a 
measurement is taken using a mouse selection. Values can also me keyed in to 
allow repeatable measurements.
 
Units are in Angstrom, nm or micron, (or pixel if chart is not calibrated)

Reference Lamda - This drop down list supports measurement of wavelength relative
to a reference wavelength.  It shows the  difference in wavelength and Doppler 
velocity. This can save a lot of time and effort when a large number of RV 
measurements are required.

The Reference Lamda drop down list  allows the following options
• [none] – no differences will be calculated.

• [auto] – the Reference wavelength will be automatically chosen if it exists in 
the selected range. (When more than one line exists in the selection, the first 
reference line from left is used).

• Select a specific wavelength from the drop down list (that is populated with 
values as per list box in the Element Lines tab).

• You can also manually key in a  wavelength value that is not in the list. e.g. 
6562.85.
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The measured value uses a Cubic Spline interpolation based on the maximum (for 
emission) or minimum (for absorption) value within the selection. The average of a  
Gaussian fit will be used instead if the Gaussian checkbox is ticked.

When used in combination with the Report Type (in Report Options tab) = 'All Profiles
by Column' or 'All Profiles by Row', then RV measurements relative to a single 
reference can be calculated for a set of profiles.

Sig. Figures – A drop down list to specify the number of significant figures for 
measurement results to be displayed. 

Note: Results are formatted after calculations are made using unrounded values

Interval – The number of slices between pixels for interpolation and area calculations.
Lower values can speed processing, but with possibly less accuracy. Default = 20

Show Results when run – A checkbox that switches to the Measurement Results tab 
when Run is clicked.

Run – A button to take a measurement. A measurement is also triggered when a 
selection has been made using the mouse. 

2.13.4 Measurements Results

The Measurement Results tab shows the calculated measurements based on the 
parameters and options specified in the Measurement Options tab.

The output format is determined by the Report Type drop down list as follows:

 Active Profile – Displays text report of active profile only for selected Result 
Options
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 All Profiles – Displays text report for every profile one above another (scroll 
down to see other profiles)

 All Profiles by Column – Displays a data grid with a column per profile

 All Profiles by Row – Displays a data grid with a row per profile.
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Results are initially calculated using raw values and then formatted to the number of 
significant figures specified. Some calculated results may therefore not always 
reconcile with calculations made using already rounded values.

Use the scrollbar or resize the screen to see more of the displayed results.

Data can be copied from the text area (for subsequent pasting elsewhere) using the 
mouse, or via the right mouse menu options on the data grid.

Note: The reported measurements will use cubic spline interpolation and may 
therefore differ slightly from the figures shown on the left hand status bar (that use 
linear interpolation).

2.13.5 Python tab

For advanced users. This tab allows selected profile data to be passed for a Python 
script by reading and writing files with a specific naming and format.

Python 2.7 needs to be installed. (Has not been tested with higher versions).
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Script files need to be placed in the <BASS Install Path>\Scripts\Measure1d folder 
where some example *.py python scripts are provided.

2.14 Reference Spectrum

The Reference Spectrum screen is available from the toolbar  or the main Tools 
menu.

The screen will display a reference spectrum which can be added to a chart. A 
Reference spectrum is commonly used for comparison or to derive a corrected 
instrument response.

The Pickles library data files used in BASS are held in the …\Reference\Spectra 
folder underneath the installation folder and have been cropped to 300nm to 
1000nm. The data originates from ESO. 
https://www.eso.org/sci/facilities/paranal/instruments/isaac/tools/lib/index.html 

2.14.1 Selecting a reference spectrum

By default, the Pickles Library is offered as the default source of reference files,  but 
you can select Miles reference profiles from the Source menu.  

See the ink to the BASS Project Astrobodger Yahoo Group to get the Miles library 
https://uk.groups.yahoo.com/neo/groups/astrobodger/links/all/Miles_Reference_spect
ra
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Select the spectral class appropriate for your image from the list on the LH panel on 
the screen. (For example select A0v for a Vega image or K5iii for Aldebaran).  The 
list is in order with the highest temperature ‘o’ and ‘b’ stars first. 

Once a class has been selected, the screen will display a binned image view and 
preview a chart. Move the mouse over the chart to display the wavelength of a 
feature.

The list of spectral classes displayed can be filtered by keying into the “Filter List” text
box on the bottom LH corner. Clear the textbox to show the complete list.

2.14.2 Adding reference spectra to the project

Once a stellar class has been selected, click on the Add Spectrum to Chart button on
the bottom of the screen. This will add the reference spectrum to the main chart as 
an additional profile.  Multiple reference spectra can be added to the main chart, if so 
desired.

Reference spectra from other sources can be added to the project as per the normal 
add image process.

Click the Close button to close the screen.  

Note: Not all stellar classes are provided in the Pickles library. An intermediate 
spectral class can be obtained by selecting two references and averaging them i.e. 
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an A2i and A2v can be stacked to provide a usable A2iii reference spectrum.

2.15 Continuum & Response Shaper

This function is available via the main Tools menu or toolbar icon . 

The purpose of this function is to create a response correction from points double 
clicked on the chart.

There are two main types of response corrections that can be created and stored 
against spectral profiles:

 Instrument Response correction – This is normally created by dividing a raw 
profile with a reference profile and smoothing the result. Profiles need to have 
been calibrated before an instrument response is carried out.

 Continuum Removal – This is also known as normalisation or rectification and 
is created by dividing the raw profile with a smoothed version of itself.

There are many ways of managing the correction data. You can save the correction 
as a separate response DAT file (as traditionally used by many other applications), or
save as a set of cubic spline points (either within the profile’s image information 
*.info.bas, or centrally within a master ResponseCurves.dat file).  

2.15.1 Screen functionality

The screen controls are described below

Target profile – this drop down list is used to select which of the open profiles that the
correction will be saved against. (Not required when saving to DAT file or master 
Response ResponseCurves.dat)
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Free Draw  - this check box will allow free hand points not following the intensity 
profile to be added

Linearise - this checkbox can be used to force existing points within the selection to 
be in a straight line. Tick before selecting a region.

Rolling Avg. - this 'Rolling Average' drop-down  will inserts the average value of the 
specified number of neighbours. This acts as a low pass filter on-the-fly.

More details are provided in the “Save Curve Options” sub heading.

2.15.2 Instrument Response creation process

This process will save the correction as a set of cubic spline points that are stored 
with the profile (in the*.info.bas file). 

 Load a calibrated but uncorrected target profile (or disable existing correction).

 Add the reference spectrum for the target spectral class (e.g. A0V for Vega).  

 
 Use the Operations screen to Divide the target profile by the reference 

spectrum 
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This creates a new profile for the divided result

 Open the Continuum & Response Shaper screen. The colour of the cursor 
and status bar text become orange to indicate the chart is in ‘continuum 
shaper mode’.

Move the screen around so that the divided profile is not obscured

 Click on the image strip of the divided profile to make it the active profile

 Starting from the left, double click on points along the divided profile that fall 
on a smooth curve that avoids sharp peaks & troughs.  As the cursor will track 
the intensity, you just need to move along the x axis. 

Note: Double click on an existing point to remove it.

Note: Increase the chart width to be more accurate when setting the data points 
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 Click Refresh to clean up the curve if necessary
 Once you are happy with the curve, set the target profile drop down list to the 

target (Vega) image, then press the Save button and select the ‘Save as 
Instrument Response for: ’ option.

You will then be prompted to apply the saved response to the target. 
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Press Ok to apply the change.  The Vega profile now follows the shape of the 
reference spectrum. The divided profile is no longer required so can be removed.

If Cancel was pressed then the results of the instrument response correction are only
visible once selected in Profile Properties. 

See how the correction can be disabled using the No Response Correction option.

2.15.3 Continuum Removal process

 Load a calibrated but uncorrected profile (or disable existing response 
correction). No reference spectrum file is needed here.

 Open the Continuum & Response Shaper screen. Move it so the profile is not 
obscured

BASS Project 1.9.9 page 116 of 168



 Starting from the left, double click on points along the profile that fall on a 
smooth curve that avoids sharp peaks & troughs. As the cursor tracks the 
intensity, you just need to move along the x axis.

Note: Double click on an existing point to remove it.

Note: You may wish to increase the chart width to be more accurate when 
setting the data points

 Click Refresh to clean up the curve if necessary. As per the screenshot below,
the continuum correction curve and points double clicked are shown in 
orange.

 Once you are happy with the curve, set the target profile drop down list, click 
the Save button and then select the ‘Save as Continuum Removal for:’ option.

 Press Ok when prompted to apply the saved response to the target.
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Click OK to see the profile with the continuum removed. If necessary, adjust the x 
axis crop range to exclude spurious results at the extreme ends of the profile.

The results of the Continuum Removal or Instrument Correction are visible when 
selected in the Correction tab of the Profile Properties screen.

2.15.4 Save Curve options

When the Save button is pressed, four options are offered:
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 Save as Response DAT file – This is the ‘traditional’ option and will prompt for 
a file name to save the correction curve as a DAT profile that can be then 
linked to the profile or even used for other applications.

To apply this correction, select the Response File option from the Correction 
tab of the Profile Properties screen, then browse or enter the file & path of the 
response file. 

 Save as Instrument Response for profile <profile name> – Select an open 
profile from the drop down list. Press this button to store points in the profile’s 
*info.bas image information file. This will prompt to overwrite if a correction 
exists

To apply this correction, select the Instrument Correction radio button from the
Correction tab of the Profile Properties screen.
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 Save as Continuum Removal for profile <profile name> - Select an open 
profile from the drop down list. Press this button to store points in the profile’s 
info.bas image information file. This will prompt to overwrite if a correction 
exists

To use this correction, select the Continuum Removal radio button from the 
Correction tab of the Profile Properties screen.

 Save to Master ResponseCurves.dat file - This will prompt for a response 
curves name and then append the points to a new line at the end of the 
master response curves data file (ResponseCurves.dat). This makes it easy to
be reused for other profiles
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.

To apply a response curve from ResponseCurves.dat to a profile, select the 
‘Master ResponseCurves.dat’ radio button from the Correction tab of the 
Profile Properties screen and then select from the dropdown list.

The contents of the points text box are available to cut/paste into your own text files if
you so wish.

Note: To redo a response correction, first turn off any existing correction by selecting 
the ‘No Response’ option in the Correction Tab of the Profile Properties screen.
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2.16 Planck Temperature Curve

The Planck temperature tool is available via the main Tools menu or toolbar .

The classification of a star depends 
not only on the size and elemental 
composition, but also the surface 
temperature. 

The Plank Curve displays the 
distribution of irradiance with 
wavelength and shows that the peak 
wavelength is determined by the 
surface temperature.  The shape of 
the continuum of a stellar profile is 
governed primarily by its 
temperature as if it was a “black 
body”.  

The screen contains the following features:

 Temperature – Generates a Planck curve for the specified temperature 
(degrees Kelvin)

 Wavelength – Generates a Planck curve for the peak wavelength entered

 Temperature – Slider provides an alternative method to set the temperature (&
peak wavelength)

 Height textbox – Specifies the height of the Planck curve peak drawn on the 
chart. This makes the curve larger or smaller. 100% will fit to the height of the 
chart.

 Height – Slider provides an alternative method to set the height.

 Offset – Textbox specifies the vertical position of the Planck curve drawn on 
the chart. This moves the Planck curve up or down.

 Offset – Slider provides an alternative method to set the offset.

 Line Width – Drop down list allows the thickness of the line to be set. A ‘0’ 
value will hide the line.

 Colour icon – The button opens a Windows colour picker dialog allowing the 
display colour of the Planck curve to be changed.

 Previous icon – Button navigates to the previous Planck curve (when 
applicable). The form caption displays the position of the current item in 
relation to the number of Planck curves (e.g. item 2 of 3 total)

BASS Project 1.9.9 page 122 of 168



 Delete button – This prompts for confirmation before removing Planck curve.

 Next button – This navigates to the next Planck curve (when applicable). The 
form caption displays the position of the current item in relation to the number 
of Planck curves (e.g. item 2 of 3 total)

 Export icon – Button prompts for a filename to save the active Planck curve as
a DAT profile. Having the Planck curve available as a profile allows operations
such as division to be performed. 

 Save icon – Button adds the Planck curve to the chart; otherwise the curve will
be removed when the chart is next redrawn.

 Close – Button closes the screen.

2.16.1 Relationship of temperature and peak wavelength

The temperature and peak wavelength textbox values are related as below

λmax  =  2897820  /  T

Where T is the temperature in degrees Kelvin and λmax is the peak wavelength in 
nanometres.

E.g. Type in 400 nm wavelength to update temperature to 7244.6K (and vice-versa). 

2.16.2 Fitting the Planck curve

The Height and Offset textboxes and horizontal sliders are provided to help match 
the amplitude and level of the Planck cure with your spectral profile. If you need more
movement than the slider allows, just enter the number in the textbox.    
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The process can be repeated with different stellar classes. Matching the Plank curve 
gets more difficult with blue stars as the peak wavelength is beyond the useful 
response. The trick is then to try to match on the shape of the descending curve. 

Editing the temperature field until a best match is found is a technique that can be 
used to help determine the temperature of an unknown star. 

The predicted temperature, however,  does not always fit as many other factors can 
come into play.

Note: Fitting the curve is easier if source profile y-axis scaling shows 0 on the y-axis. 

2.16.3 Managing Planck curves

The screen shows the details of the current Planck curve and provides the ability to 
navigate, add, edit and hide multiple curves.

Planck curves are listed in the Chart Legend in the descending order of Temperature 
(i.e. hot curves are displayed above cooler curves).  

The Temperature field uniquely identifies each curve so only one Planck curve is 
allowed per Temperature. If you edit a curve to use an existing Temperature then the
previous curve will be overwritten.  If you edit the Temperature and Save then a new 
curve is created using the new Temperature. The original will still exist but is easily 
discarded using the Delete button.

The Line Width drop down allows the width to be set or the curve to be hidden

After a Planck curve is saved, the list is resorted and the first curve is selected.

2.17 Resample Profile

The Resample function is available from the main toolbar  or under the Tools 
menu. You must select a profile before invoking this function. In addition to 
resampling profiles, this screen also allows filters to be applied.
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The chosen profile that will be 
the source of the resample is 
shown in the screen caption. The
source profile will NOT be 
overwritten. This function can 
only add one or more new 
profiles.

The screen provides Interval and
Filter tab headers

2.17.1 Interval tab

This allows the sampling interval to be set that will be applied to a cubic spline curve.
 
Interval – a drop down list containing a list of interval values. If the profile is calibrated
then the unit will be nanometers, otherwise it will be pixels. You can also type in 
values that are not in the list. 

Reset to [X] – button that resets the interval to the current average interval X.
 
A smaller interval results in a larger number of points, e.g. setting to 0.5 for an 
uncalibrated profile will double the number of points.

2.17.2 Filter tab

This screen provides options for applying low or high pass filtering to the profile. A 
Filter can be used in combination with the Sampling Interval value.
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Filter Type – A drop down list containing the following filter types

 [none] – no filter will be applied
 Low Pass – use for general smoothing 
 Low Pass Gaussian – finer low pass filtering
 High Pass – Signal minus Low Pass value
 High Pass Gaussian – Signal minus Low Pass Gaussian value

Filter amount - a textbox to enter the Filter value. Higher values increase the effect of
the filter.

Filter Slider – a horizontal slider bar provides an alternative means of setting the 
Filter value. Allows changes to be seen in real-time. Use the forward and back arrow 
keys for fine changes

2.17.3 Common settings

The controls on the base of the screen apply to both the Interval and Filter tab 
headers

Manual scale to source – A checkbox that overrides the default autoscaling of the Y-
axis. This manually scales the filtered profile to the same scale as the source. The 
scaling values can be seen in the Y-Axis tab of the Profile Properties screen.

Note: The Manual scale checkbox may be better turned off for high pass options.  

Linear Interpolation – a checkbox to use linear instead of cubic spline interpolation.

FITS – A checkbox to set the format of newly created profile(s) as FITS format. The 
‘off’’ setting will use a DAT format.

Add for each open image – a checkbox that will create an additional resampled 
profile for every open image, when ticked.

Refresh – a button to update the resampled profile after changes have been made.

Add Profile – a button to add a new resampled profile(s) to the chart and then close 
the form. The caption of the new profile is concatenated using the original profile 
name.

Highlight Profile – a checkbox to show the interpolated profile bold (as a thicker line)

Close – close the form without adding a new profile
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2.17.4 Producing a linear wavelength profile

Interpolating a calibrated profile will generate a constant wavelength interval between
data points. This is useful when the source has a very non-linear calibration (e.g. a 
prism spectrum).

This function is used by the Save 1D function to create a linear profile when the 
source profile has a non-linear wavelength calibration.

In the example of a prism spectrum below, the raw blue points are more widely 
spaced at the red end of the spectrum. The resampled red points are constantly 
spaced.

2.17.5 Increasing the sampling interval for interpolation

Increasing the interval can have a benefit in a smoother curve making the 
interpolated min/max easy to visualise.

Note: Choosing too small an interval can just make the profiles unnecessarily large 
and slow things down. 
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2.17.6 Using the Low Pass Gaussian option to smooth out noise

Subtle filtering using the Low Pass Gaussian option can be used to reduce the 
noisiness of a profile.

This is a useful tool which can be applied to comparison spectra, to bring a high 
resolution spectrum to a more appropriate resolution.

2.17.7 Using the Low Pass option to create a continuum

Substantial Low Pass filtering on a profile can be used to generate a smooth 
continuum that could be used to derive a continuum removal response.

2.18 Trend Line

The Trend Line function is available under the Tools menu. It basically creates a new
profile by applying a linear or polynomial regression from the source

BASS Project 1.9.9 page 128 of 168



The horizontal slider sets the degree of the polynomial (1=linear) which is displayed 
in the box on the right. The coefficients are displayed below the slider.

2.18.1 Trend line for response correction

The Fit To Edge drop down list may be helpful when using this function to create a 
response correction.

Pressing Add Profile will add the curve as a new DAT profile to the project.

2.19  Animation

The Animation function is available from the toolbar icon  or the Tools menu. 
This will create an animated GIF file from either open profiles or a set of saved 
pictures.

This function uses the GIF animation component created by gOODiDEA.NET that is 
licensed under The Code Project Open License (CPOL)
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2.19.1 Create animation using open profiles

Use this option button to specify that open profiles in the current BASS project will be
animated. The details of each profile, such as colour, the displayed caption and 
animation sequence are defined in the Profile Properties screen. 

The dimensions and colour of the GIF file created will be the same as the chart and 
can be modified using Chart Settings.

 Use top profile colour – a checkbox to make all frames use the same colour 
(as the first profile).

 Show each profile added – a checkbox that will add successive profiles to the 
chart. (Only a single profile is displayed at once otherwise).

 Captions in sub title – when checked, the legend is hidden and the caption of 
each profile is displayed in the sub title area above the chart. Obviously, any 
existing sub title won’t be displayed in the animation. When this option is not 
checked, profile caption is displayed at the legend start position

 Save each frame – a checkbox that will save each frame to a file. Each file will
named ‘Frame + <profile sequence>’ and will be saved in the same path as 
the output GIF file. A warning will be given when overwriting frame*.png files. 
Best to manually clear out existing files first.
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2.19.2 Create animation from saved pictures 

Use this option button to specify that picture files selected will be animated. Using 
picture files can be more complex, but ultimately allows you greater control to modify 
each picture in a graphics tool prior to animation.

 Pictures list box – a read only list box that is populated by files selected using 
the adjacent browse button. Pictures are processed in alphabetical order.

Files can be removed from the list by selecting and pressing the Del (delete) 
key.

 Picture browse - a button to browse for picture files to be animated.

2.19.3 Animation settings panel 

This contains GIF file options.

 Delay – a textbox to specify the delay (in milliseconds) between frames. 
Default value is 1000ms (= 1 second).

 Repeat – a textbox to specify the number of times the GIF file will repeat the 
set of frames. A value of 0 will repeat forever.

 Output file – a textbox containing the file and path of the GIF file to be created.

 File browse - a button to browse for the file and path of the output file.

2.19.4 Remaining screen controls
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 Launch output file – a checkbox that will start a Windows process to run the 
animated GIF file when OK is pressed. Within Windows. a GIF file must be 
associated with an application capable of playing an animated GIF (e.g. 
Internet Explorer) otherwise no animation will be seen. 

 Ok – a button to initiate the creation of the animated GIF file in the Output file 
location.

 Close – a button to close the form.

2.20 Atmospheric Extinction Screen

This screen is available from the Tools -> Atmospheric Extinction menu and is used 
to model atmospheric extinction and output an extinction profile based on chosen 
parameters such as site altitude, line of sight angle, wavelength range and interval 
etc. The profile can then be subsequently applied (via division operation) to target 
spectra to correct for atmospheric extinction.

This function does not correct for telluric absorption lines, see the H20 screen 2.24.

The calculations are based on a Fortran function provided to me by Tony Mallama 
(where the extinction formulas originated from a Christian Buil spreadsheet).

The following options are available

Elevation – enter the site elevation (metres above sea level)

Altitude – enter the line of sight altitude angle (degrees). The default 90 degrees 
value corresponds to the zenith.

Wavelength Range – enter the start and end wavelength ranges (in unit specified 
within BASS). The default range is 3000 to 10000 Angstroms.

BASS Project 1.9.9 page 132 of 168



Interval – select the sampling interval (in unit specified within BASS). The larger the 
number selected the fewer points in the profile. The default is 10 Angstroms (=1nm).  
For comparison, the Pickles reference spectra use a 5 Angstrom interval.

Extinction Options – choose one or more sources of extinction from the three options 
provided. All three are selected by default.

Magnitude scale – Tick the checkbox to create a profile in magnitude units. The 
default ‘off’ position will output as flux, which is the option to use for operations within 
BASS.  The magnitude scale is useful for photometric purposes (outside of BASS) 

Add Profile – Click the button to add a new extinction profile to the current project. 
You can remove an unwanted profile while keeping this screen open by selecting the 
image strip and clicking on remove profile.

2.20.1 Using the extinction profiles

The extinction profile can applied to target profiles using a standard division 
operation.

Profiles are saved to disc as a DAT files using the standard options within BASS.

The default extinction profile caption is a long string that shows the parameters 
chosen, to help you distinguish between them. You can edit the captions using the 
Profile Properties screen.  

Each profile added is automatically scaled to fit the chart area. Modify the scaling on 
Y axis Tab of profile properties if you wish to compare extinction profiles on same 
scale. The shot below shows extinction for 20, 30, 45 and 90 degree altitudes.
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2.21 Reconstruct Image screen

This screen will scan spectra from an AVI file or a set of images in order to construct 
an image filtered by one  or more wavelengths.

Thanks to Fulvio Mete for providing the data to construct the Solar image above.
 
The functionality is described in the BASS Spectroheliograms and image 
reconstruction from spectra PDF document available at the link below:

https://www.dropbox.com/s/oaet87fs3110ub3/Spectroheliograms%20and%20image
%20reconstruction%20from%20spectra.odt?dl=0

  
2.22 Doppler Shift screen

The Doppler Shift screen contains three tab headers.
• Calculate Velocity Correction 
• Apply Velocity Correction
• Doppler Utility 

2.22.1 Calculate Velocity Correction tab

This tab performs the Doppler shift calculation and requires three sets of data 
organised into panels

 The Right Ascension and Declination the target object. 
 The Latitude, Longitude and Elevation of the observing site location. 
 The date and time of the mid-point of the observation (in universal time)

Values can be keyed in directly or pre populated from the FITS header if the screen 
is invoked from the BeSS Settings screen.
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Target panel 
The RA and DEC are in decimal degree format and will be read in from the FITS 
header. These can also be keyed in or populated using the Simbad button to query 
an object name.

The RA button calls the Right Ascension 
popup to allow input and translation 
between the following formats

 hh mm ss.ss 
 h.hh (decimal hours) 
 d.dd (decimal degrees)

As you update one field the remainder are 
automatically converted. 

Press Ok to pass the new value back to the 
calling screen
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The DEC button calls the Declination popup
to allow input and translation between the 
following formats 

 dd mm ss.ss
 d.dd (decimal degrees) 

As you update one field the remainder are 
automatically converted. 

Press Ok to pass the new value back to the 
calling screen.

Site Location panel
The latitude, longitude and elevation are read from the FITS header and saved when 
Update is pressed. Positive values are East. 

Note that the BeSS Settings screen provides the ability to manage site locations

Observation Date - This is calculated as the ‘mid point of exposure’ when start date 
(DATE-OBS), end date (DATE-END) and/or exposure time (EXPTIME) fields are 
populated in the FITS header.  The BeSS Settings screen provides better means to 
set these fields.  

The “…” button opens the Date & 
Time Setter pop-up that allows input 
and conversion of dates in the 
following formats

 YYYY-mm-dd hh:mm:ss 
 decimal day dd.dd/mm/yyyy  
 Julian date  /Modified Julian date

As you update one field the remainder 
are automatically converted. 

Press Ok to pass the new value back 
to the calling screen.

Use the Zone Shift button to 
convert local to Universal time, 

E.g. if you are +2 hours ahead you
enter -2. This is less fiddly than 
editing the hours in the date box.
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Pressing the Calculate button will run the velocity calculation and populate the result 
into the box provided.  However, if the following message is shown, check you have 
correctly installed the PythonRunFiles folder.

When ‘Update FITS header’ is pressed the following fields are updated:

 Calculated velocity (BSS_RQVH ). 

 Target object name, RA and DEC

 Site latitude, longitude & elevation. (Note: Negative West values are converted
to be  0 to 360 degrees)

Important: If start date and exposure time fields are already populated in the FITS 
header, then changes made to the observation ‘mid-point’ date are NOT saved.  
The reasoning is concerned with issues ‘back fitting’ data when the calculated mid- 
point is changed. Use the BeSS Settings screen to manage these fields.

2.22.2 Apply Velocity Correction tab

This screen will create a new profile that applies the Doppler shift to the current 
profile. The correction will be of opposite sign to the measured velocity. For example 
if the target velocity is blue shifted by +16 km/s, then the correction will apply a red 
shift of -16 km/s to return the spectrum to the ‘at rest’ state.
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The creation of the new profile usually requires resampling. This uses the 
interpolation and interval settings: 

• Interval - The default Interval value is based on the lowest interval of the 
source profile. This can be edited if the checkbox is ticked

• Linear interpolation – this checkbox prevents interpolation using the default 
cubic spline method. 

The applied Doppler correction is saved to the FITS header (in the BSS_VHEL field). 
Linear FITS calibration parameters are also calculated and saved where the source 
profile used non-linear calibration.

2.22.3 Doppler Utility tab

This tab allows various conversions between velocity and wavelength to be easily 
carried out. It does not save any values to the FITS header or modify any profiles.
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Use any Wavelength unit of your choice, but be consistent.

The functionality can be explained with some examples below:

Q1: Find the Hydrogen alpha line wavelength when blue shifted by 10 km/s
• Enter Hydrogen alpha Rest Wavelength as 6562.82 (Angstroms)
• Enter Velocity of 10 km/s
• As Rest Wavelength and Velocity are edited, the Observed wavelength and 

Delta are automatically calculated.

Q2: Find the velocity for a wavelength change of 0.15 Angstroms of Hydrogen beta
• Enter Hydrogen beta Rest Wavelength as 4861 (Angstroms)
• Enter Delta =0.15
• The Velocity is automatically calculated when Rest Wavelength, Delta or 

Observed wavelength are edited.

2.23 Cross Correlation Screen

This tool is accessed from the Tools menu. It performs a one dimensional cross 
correlation of two profiles in order to determine the Doppler shift between them. This 
provides an alternative to calculating the Doppler shift by measuring individual 
features or dips. Cross-correlation is a measure of similarity of two profiles as a 
function of the velocity displacement of one relative to the other.
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Please refer to the BASS Cross Correlation document for a detailed explanation of 
the process steps involved. https://www.dropbox.com/s/sbxy9kr3txdz6d3/BASS
%20Cross%20Correlation.pdf?dl=0  

2.24 H2O Correction Screen

The screen is accessed via the Tools menu. The purpose is to remove features 
caused by telluric water lines

2.24.1 Screen components

The screen components are:
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• Filter – a textbox and slider that are used to set the amount of low pass 
filtering to be applied to the H2O reference profile lines. The goal is to adjust 
the resolution of the H2O reference lines to match those in the source profile.

• Amplitude – a textbox and slider that are used to match the intensity of the 
H2O reference lines to match those in the target.

• Lamda Align – a textbox and slider that are used to match x axis position of 
the target with the reference profile.
 
The need for wavelength alignment could be calibration error. If it is only 
possible to align a limited part of the profile, then the target profile may need to
be recalibrated, paying attention to the ‘calibration fit’ (e.g. quadratic, cubic).
 

• Highlight profile – a checkbox that increases the thickness of the result line to 
make it more prominent which can help with adjustments.

• Apply correction – a checkbox that show the result of the source profile 
divided by the H2O reference when ‘on’. When ticked ‘off,’ it shows the H2O 
profile.

• Scale to source – a checkbox (ticked ‘on’ by default) that sets the scaling of 
the result to be the same as the source profile. This normally best left ‘on’.
 

• Refresh a button to redraw the result. Especially after edit of Lamda, 
Amplitude or Filter text boxes.

• Add Profile a button to add the result profile to the project.

• Close a button to close the screen

• H2O Profile – a drop down list to select which H2O reference profile to use. 

2.24.2 Prerequisites

• The source profile must be calibrated and be the top profile in the project.

• The source profile must have flux normalised to ‘1’ (otherwise the h2o 
correction might not be visible). 

• H2O reference profiles need to be installed in the \reference\h2o folder under 
the BASS Project installation

• The source profile much match the wavelength ranges of one of the H2O 
reference profiles provided.

2.24.2.1 Applying correction

Click on the top source profile to be corrected before opening the H2O screen from 
the Tools menu.
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Start off with the ‘Apply Correction’ checkbox turned ‘off’ to set the Filter, Amplitude 
and Align parameters in the ballpark, then switch ‘Apply Correction’ on and readjust 
to try to make the h2o lines disappear.

Adjustments of Filter, Amplitude and Align can be rather fiddly. Fine adjustments are 
possible using the arrow keys on the selected slider. The screen can be resized to 
increase the width of the sliders.

Values outside the range or unobtainable using the sliders, can be entered directly 
into the adjacent textboxes, (press Enter or click Refresh). 

The green profile above shows the blue source profile after H2O correction

2.25 Phase Plot Screen

A phase plot is a two dimensional surface representation with wavelength on x axis, 
phase (or time) on y axis. The colour denotes flux.  
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You must have the PythonFileFiles folder installed to run Phase Plot options.

For clarification – you don’t need to install the Python language yourself. The zip 
file contains compiled executable applications and includes dependencies.

Functionality is described in the short tutorial available at the link below:BASS Project
Phase Plotting v1.9.4

2.26 Labels Screen

The Labels screen is invoked from a toolbar icon  , the main Tools -> Labels 
menu or the context sensitive chart menu 

When the screen is opened, the chart will be in “Add Label mode” with the status bar 
text shown in green.

The Labels screen provides options to 
set display colour, text properties and 
how a line should be displayed. The label
itself is created by using the mouse to 
draw a rectangle on the chart, positioned 
at the feature to be displayed.

Note that the font used for labels 
can be set in the Advanced tab of 
the Project Settings screen.

Tab Headers –Select option for: 
 Add Label - Set label type and properties of the new label (changes to “Edit 

Label” if an existing label is being modified). 
 Manage Labels – This displays existing labels in a list. This allows any label to

be modified or removed.
 Greek Alpha – allows letters from the Greek alphabet to be copied/pasted into 

label text.

Label Annotation Type – this panel allows a choice of label types:
 Label Only – displays a text block (without any lines) at the location selected 

using the mouse on the chart.

 Full Line & label – as Label Only, but includes a full height vertical line at the 
wavelength position.
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 Scaled Element line – draws a Gaussian curve or line at the element position. 
A line is drawn when the Sigma value in the Elements tab of Chart Settings 
has a zero value. A non-zero value plots a Gaussian curve with the specified 
sigma (standard deviation).
 

 Free Line & Label – draws a line from the start to the end position where a text
block is positioned. Unlike Label & Full Line, this line can be any length or 
angle.

 Molecular Band – draws a graduated icon at the selected location. The 
graduation can be left to right or reversed depending on the text justification.

Colour picker – allows selection of the text display colour (and line where applicable) 

Text Justification – these options allow a choice of how text is aligned (justified)
 Left – the text is left justified and the text block is positioned to the left of a line 

(if a line exists).
 Centre  - the text is centrally justified and the text block is centred on the line 

(if a line exists).
 Right – the text is right justified and the text block is positioned to the right of a

line (if a line exists).

Text Orientation – these options allow a choice of how text is orientated
 Horizontal – text is horizontal
 Vertical Clockwise – text is rotated 90 degree clockwise
 Vertical Anti-clockwise – text is rotated 90 degree anti-clockwise

Wavelength – this  textbox is provided to key in X-axis position more accurately than 
using the mouse.

Intensity - this textbox is provided to set the Y-axis position as a percentage of the 
chart height (0 to 100).  For Scaled Element Lines, this intensity value is contained in 
the element data file and often exceeds 100. 

Element - this text box is provided to optionally specify an element name or symbol. 
Note that the height of scaled element lines is relative to those of the same element.  

Line Style – this drop down list provides a choice of line styles is provided (e.g. solid, 
dashed etc.)

Arrow Head – this checkbox shows an arrow head cap that is used to point at a 
profile feature  For Free Line & Label annotations only.  

Previous icon– this button navigates to the previous label, if applicable.  This sets the
screen in ‘edit’ mode allowing changes to the current label to be made.

Remove icon  – this button removes the selected label

Add icon – this button sets the screen in ‘add’ mode ready for a new label to be 
added.

BASS Project 1.9.9 page 144 of 168



Next icon – this button navigates to the next label, if applicable. This sets the screen 
in ‘edit’ mode allowing changes to the current label to be made.

Save icon – this button updates the chart with the label and remains in ‘edit’ mode 
allowing the label just saved to be adjusted/edited.

Don’t forget to save the project after you have come out of the labels screen.

Close – this button closes the form

The screen shot below shows some annotation examples.

2.26.1 Adding a label

The screen can be in one of two modes; ‘add’ or ‘edit’ as displayed on the screen 
caption. Add mode is the default, otherwise press the Add button.

 Select the Label Annotation Type.

 Click on the chart to select the position. The label textbox and/or line 
(depending on line type) will be positioned at the point where the mouse is 
used to draw a rectangle or line. This can be the position of the spectral 
feature line to be annotated.

 The text area will, by default, be populated with the wavelength (or pixel if not 
calibrated) at the starting label position. 

 Overwrite this with your own text. Press the Enter key to format the text with 
carriage returns (multiple lines) if required.
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 Press the Save button to add the label to the chart. 

 Don’t forget to save the project as labels belong to a project.

Once saved, the screen is in ‘Edit’ mode allowing you to make adjustments or 
changes. Press the Add button to add more labels.

2.26.2 Editing a label

Clicking on the Manage Labels tab header will display a list showing all the labels on 
the chart. This list and the navigation buttons provide the mechanism by which labels
are selected for edit or removal.

Clicking on a row in the list of labels will put the Labels screen in ‘Edit’ mode.  This is 
confirmed by the 1st tab text changing to “Edit Label’ and the screen caption “Label x
of y” (where x is the index of the label being edited; y is the total number of labels on 
the chart). 

Changing row will display an editable textbox at the text position, (or draw a border if 
it’s a molecular band). To change the position of the text, just reselect or draw the 
new position on the chart.
 

Hint – you may find it easier to temporary save the label to move the screen out of 
the way if you wanted to make fine adjustments.

To change the colour, or other properties of the label, double click on the row or click 
on the Edit Label tab header.
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Note: You cannot change the line type (e.g. you can’t change a ‘Label Only’ to a 
‘Molecular Band’). Delete the old and add a new label. 

Press the Save button to save changes to the chart. Don’t forget to also save the 
project if you want to keep changes for next time, or save as a Label Set if the 
annotations are not specific to a project. 

A molecular icon can also be resized by having it selected and then clicking on it to 
show the yellow selection points on the sides and corners. 

If you don’t wish to save the label, click on another row, press the Add button or close
the screen.

2.26.3 Removing a label

Navigate to the label to be removed then click on the ‘Remove’ button. Confirm 
removal when prompted.

Removing a label reverts the screen to ‘Add’ mode. To navigate to another label to 
be removed, either use the previous/next buttons or click on the row in the Manage 
Labels list.

Labels and annotations may be removed in bulk in the Manage Labels tab by first 
selecting one or more items in the grid and clicking the Delete button. 

A Clear button is also provided in the Manage Labels tab to delete all labels and 
annotations.

BASS Project 1.9.9 page 147 of 168



2.26.3.1 Using Greek letters

2.26.4 Managing Label Sets

This tab provides three buttons to manage sets of labels

 Clear  – this button will prompt to remove all label objects from the chart. 
 Load Set – this will add label objects that have been previously saved to a *.lbl

text file to the project Loading a set does NOT clear labels already loaded. 
This is deliberate as it allows you to merge sets of labels

 Save Set – this will save all chart label objects to a *.lbl text file
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The third tab provides a multiline read only
textbox allowing Greek alphabet 
characters to be copied for pasting 
elsewhere.

The list text is populated by the 
\Reference\GreekAlpha.txt file off the 
installation folder

The Manage Labels tab of the Labels 
screen allows you to save a set of labels to
be applied to other projects. This is an 
alternative to the functionality to save 
labels in a project. The main difference is 
that Label Sets are designed to be used 
across different projects where profiles can
have different dispersions. 

The position of label sets is based on 
wavelength so should be created  based 
on a calibrated profile.



2.27 Export Project Data

The Export Project Data function is available from the toolbar icon  or the Tools 
menu. 

Start Wavelength textbox – Enter the wavelength the export will start from. The
Default value is wavelength of the first pixel from the top profile

End Wavelength textbox – Enter the wavelength the export to. The
Default value is wavelength of the last pixel from the top profile

Interval dropdown list – Enter or select the interval between successive rows 
exported. Lower values will increase the number of points exported (and take longer 
to process).

Export button – Starts the export

Close button – Close the form

Data is exported to a tab delimited text file selected from a Windows file save dialog. 
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table using cubic spline interpolation 
to provide intensity values for 
common wavelengths. 

The export requires the top profile to 
be calibrated.



Once the data file has been saved, you are prompted with the option to launch the 
file.

Launching the file will run whatever application is associated with the saved filename 
extension. This is typically Microsoft Excel, but should also work for OpenOffice, or 
other spreadsheet applications that support tab delimited files. Please allow time for 
the application to start, this can be 30 seconds or longer.

Select Yes if the spreadsheet application prompts to open the file.

An example of a project export is shown below. As the data is in unformatted tab 
delimited format, you may need to manually adjust the column widths to suit. 
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2.28 BeSS Settings

A ‘BeSS Settings’ screen has been provided that allows the user to update the FITS 
header with the information required to allow a one dimensional  FITS profile to be 
imported into  BeSS standard compatible online databases such as BeSS, BAA and 
ARAS. 

Although only experienced/advanced users would be the most likely to actually 
submit spectra to BeSS, this functionality and be used by the less advanced to store 
useful information into the FITS keyword fields.

Start by loading a calibrated one dimensional FITS image.

The BeSS screen is accessed from the Image menu or from the “BeSS” button on 
the General tab of the Profile Properties screen.

The screen provides multiple tabs organised to capture the required fields. There is 
also a tab provided to display error messages when the ‘Validate BeSS’ field is 
clicked.

Details regarding BeSS format and validation rules can be accessed from this link to 
the BeSS standard. 

2.28.1 Acquisition Reference Data

The first tab collects Acquisition Reference Data.

The Observer, Site Name and Equipment fields provide Save and Delete icon 
buttons to manage locally stored values.  These values would need to have been 
setup online in BeSS before files will be accepted for upload.  The values are held in 
local text files under the <BassProject Install>\Reference folder.
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The BeSS standard allows site and equipment to be identified either by a composite 
name or individual component fields.

Once a Site Name and its components are saved, selection using the Site Name 
drop down list will automatically populate Latitude, Longitude and Altitude. 

Once an Equipment configuration and its components are saved, selection using the 
Equipment drop down list will automatically populate Telescope, Spectrograph and 
Camera. 

The bottom section of the screen is common across all the tabs. This provides

BeSS Icon link – link to the BeSS spectral online web site. You can get details of the 
BeSS standard requirements for submission here.

BAA Icon link – link to the British Astronomical Association spectra web site

ARAS Icon link – link to the ARAS spectra database

Reload – button to re-populate the fields with what is currently saved in the FITS 
header

Validate BeSS -  button to validate fields are consistent with the basic BeSS rules. 
When an error is found, the screen switches to the Error tab which displays each 
error message and tells the user which tab header is relevant. 
The validation is local, i.e. there is no real-time connection to the BeSS web site.
See the BeSS website for details of the validation.
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Save FITs header – button to save the contents of fields to the FITS header and 
prompt for the file to be saved. This does NOT validate against the BeSS rules.

2.28.2 Object tab

The Object tab allows the object to be specified. 

A Simbad button validates the object exists and populates many other fields using 
the Simbad online database (so requires an internet connection).

The View Simbad link loads the web page to validate the object exists and is of Be 
type for submission to BeSS. (Other on-line databases such as BAA or ARAS are not
restricted to Be class objects).
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2.28.3 Acquisition Details tab

The Acquisition Details tab provides additional information such as calibration and 
when the object was captured.

The ‘Read from Profile’ button populates calibration data held in a BASS Profile into 
the FITS header fields required for BeSS.   

You can choose to convert between Angstom or nm by selecting the unit before 
pressing the ‘Read from Profile’ button.

The FITS header keywords can only store a linear calibration. If a higher order 
calibration was performed, the average dispersion can be used, however it will be 
better to use Save to 1D function to linearise the profile by resampling.

The date + time panel allows start and end dates or one date and duration (seconds) 
to be specified.  Date and time values can be adjusted using the date + time picker 
tools provided. (Dates are saved in the FITS file in yyyy-mm-ddTHH:MM:SS format.

2.28.4 Processing tab

The forth tab provides details of processing and what corrections have been applied. 
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The Calculate button calls the Calculate Doppler Shift functon to return a velocity 
correction.

2.28.5 Comments tab

The Comments tab allows management of the HISTORY and COMMENT keywords 
that can exist multiple times
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By default new entries are added near the end of the FITS Header. Press Reload 
after Save to see the allocated row number. The row number can also be edited to 
position at a particular point. 

See the FITS Header screen to see the complete list of keywords and values in a raw
sequential format.

2.28.6 Non-BeSS Keywords

Although the BeSS standard is the most widespread, it is targeted at Be class stars 
and may not contain all the keywords required for non-BeSS spectroscopic 
campaigns. 
  
Additional FITS Keywords that are not required by the BeSS standard can be 
configured using a text based configuration file to be captured and/or validated in a 
'tab 5' in the BeSS Settings screen.

The tab will only be visible if the 'NON_BESS_KEYWORDS.txt' configuration file 
exists in the BASS installation folder.

An example configuration file can be found from this link 
https://www.dropbox.com/s/c57m6auwm2c5eal/NON_BESS_KEYWORDS.txt?dl=0

See the following document for more details
https://www.dropbox.com/s/no6jfgykcf2nfgt/BASS%20non-BeSS.pdf?dl=  0 
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2.28.7 Errors tab

Shows warning error messages after the Validate BeSS button has been clicked

 

If no errors are detected, a positive confirmation is provided.

The validation checks here are indicative and not as rigorous as BeSS on-line. (For 
example, there is no local validation that the object is a Be class star). The on-line 
BeSS file checking tool should be used before final submission to BeSS.

Note: The validation checks are for information only as the BeSS rules may not 
always be appropriate to what you are doing. For this reason, you can still save a 
profile and disregard validation messages. 
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3 Appendix A – Calibration Export data file

The calibration export data file mainly aimed at advanced users who understand 
polynomial regression and can generate appropriate charts using the data exported.  
The main aim of this is to identify how good the fit will be and in particular if any 
mathematical inflection has occurred (i.e. if the slope has changed from positive to 
negative or vice-versa).

The content of calibration data file contains the following:
 A table showing data captured from the data grid in the BASS screen
 The linear best fit line offset and slope   
 The polynomial terms according to the selected order
 A table of values over the chart range using the following columns 

o Pixel (column A)
o Wavelength calculated using Linear fit (column B) 
o Wavelength calculated using the polynomial degree (column C)
o Delta, the difference between the calculated linear and polynomial 

wavelengths (column D).

It is beyond the scope of this document to describe every analysis possible. Creating 
a chart using column D, will show the divergence between the polynomial and linear 
fits. Adding more calibration points at the ends of the chart can stabilise the curve at 
the extremes. Some divergence is to be expected because spectra will not be 
perfectly linear.

BASS Project 1.9.9 page 158 of 168



4 Appendix B - Known issues & Trouble shooting

The known issues are listed below:

1. The chart excludes the number of pixels corresponding to any manual image 
strip offset alignment for un-calibrated profiles. 

2. Intermittently, on application startup, an error message as shown in the image 
below may be raised. Pressing continue is normally fine. If in doubt restart the 
application.

3. The image strip view shows a red cross/lines on Windows XP systems when 
loading a profile or image > 32768 pixels wide.  There is also a popup error 
message. A workaround is to set Image Strip View to one of the stretch modes
before loading the large profile. The profile can then still be processed 
normally using BASS.

4. Out of memory errors can occur when a large amount of images are loaded, 
especially from a DSLR.  A workaround is to crop the images to remove 
unused regions, normally above and below the spectrum, but allowing 
sufficient for sky subtraction where necessary.  The Bulk Image Manipulation 
screen provides tools to crop images.

The 64-bit version allows significantly more images to be loaded that the 32-
bit.

5. Where has my profile gone? Try the following:

• If sequence position is > 1 then check pixel or wavelength range overlaps that 
of the chart.  Try moving the profile to the top (sequence = 1)
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• Check manual scaling range is comparable with the displayed Y-axis range, 
try enabling auto scaling.

• Check wavelength range in Chart Settings is consistent for your wavelength 
unit. (e.g. easy mistake to set 380 to 800 when in Angstroms when it should 
be 3800 to 8000).

• Check in Profile Properties that the profile is not hidden. (Line Width = 0 and 
Line Marker = no marker will hide it).

• Check the Line Colour is not the same as the chart background.

• If an instrument correction or continuum removal has been applied, check for 
inflection at the ends of the chart. Crop the x range displayed if necessary or 
temporarily disable Response correction to check profile can be seen.   

Spectrum with continuum removal is visible once excessive x axis range is cropped
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5 Appendix C – Rotate/Tilt/Smile/Slant correction

The following examples illustrate some of the different issues that can be apparent 
on spectral images and help clarify the terminology used.

The first image represents a correct image where the dispersion is horizontal and the
absorption (or emission) lines are vertical.

The next image shows a spectrum rotated. The dispersion is not horizontal and the 
lines are not vertical. This can be caused by the camera not being horizontal to the 
dispersion axis (of the prism or grating).

The next image shows Slant. The dispersion is horizontal, but the lines are not 
vertical. This can be caused by the slit not being vertical, or by trailing on a moving 
target when not using a slit. Capturing a slit-less spectrum without an RA driven 
mount can also produce slant.
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The next image shows Tilt. The dispersion is not horizontal, but the lines are vertical. 
This can be caused by rotating the camera to compensate for a non-vertical slit. 

The next image shows Smile. The lines are curved. This can be caused by optical 
misalignment or other aberrations. This issue is more likely to be seen in Littrow 
spectrographs. There is also the possibility of horizontal smile.

Of course, the issues can also appear in combination, for example slant + smile as 
shown below. 
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6 Appendix D – Amendment History

The amendment history since version 1.9.0 is shown below. Refer to the 1.9.7 User 
Guide to see earlier amendments from earlier versions. 

Version Notes
1.9.0 (includes 
1.8.3 beta 
changes)

New screens
Calculation of barycentric velocity correction using Python PyAstronomy
Apply velocity correction - to create a new corrected profile
Doppler Utility – calculate between velocity and wavelength change

Pop-up dialogs make setting and converting between different formats of date, right 
ascension and declination easier 

BeSS Settings screen – Simbad button will populate RA, DEC, spectral type fields 
(internet connection required). Negative latitude values are made positive (+360)

Calibration Lines screen – new Suggest button added. This will make a suggestion 
of the wavelength of a calibration point (once at least two points have been set).

Atmospheric Extinction screen – shows air mass ratio when altitude is keyed 

Profile Properties – The Correction tab has been renamed to Response

1.9.1 BeSS Settings screen – added Comments tab for comments & history entries.

Colour image strip views – RGB channels become white when saturated

Bug fix – Site and Equipment textboxes limited to 40 characters 

Bug fix – DAT files when ‘Save to 1D’

1.9.2 Prototype of Phase Plot screen

1.9.3 New Phase Plot screen
A 2d surface plot with wavelength on x axis, phase (or time) on y axis. The colour 
denotes flux. This requires the PhythonRunFiles folder to be installed. 

FITS Header screen
Text search added for keywords or values

Calibration Lines screen
New Barycentre checkbox

Measurements screen 
Julian mid-point date field added to reports
Barycentre measurement option added
X and Y data plot tool added for multiple profile measurement

Continuum & Response screen 
New Linearise checkbox option to force points within a selected region to be in a 
straight line

BeSS Screen
Validation added to check projected rotational velocity is 0 to 1000km/s. If yours is 
negative, you must either set it blank or make it positive for the BeSS database to 
accept your submission.

1.9.4 Phase Plot screen
The 'Show Phase' checkbox has been replaced with a new 'Mode' drop down list in 
the Y-axis panel. The three drop down list options are:
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 Time Series -This plots elapsed days

 Phase - Plots days in a rolling phase period

 Sequence - This equally spaces each profile along the y-axis. Since Date-
Obs is not used, this option works with DAT profiles

Resample screen
Bug fix for filter issue on high resolution calibrated profiles. Filtering is now done 
prior to resampling.

1.9.5 Measurements screen
 Include pixel value in calibrated FWHM result. E.g. 

FWHM           : 26.262Å (R = 250 @6562.8Å) 7.6981px

 Fix – correction to FWHM on un-calibrated profile when wavelength unit not 
nanometres

Copy binning zone from target to calibration image
Uses a new right mouse click context menu option

Stack Images screen
 Now supports use of dark scaled frames, (where exposure times of light and

dark frames don’t exactly match.

 A new textbox to allow a manual dark frame scaling factor to be applied to 
dark frames. Needed when exposure times are not in FITS header.

 Cosmetic file entry is now included when file list is saved and opened

 Master images (now prefixed ‘_BassMaster’) are now only created when 
there is more than one frame. 

Prevent invalid starting Pixels
Prevent invalid pixels when creating a new profile using a smaller instrument 
response. For example, when applying a response file whose starting range is less 
than that of the target profile. 

Stitching Profiles
Fix – Calibration values are now preserved when Save As 1D used

Apply Velocity Correction
Function is reinstated following issue created in 1.9.4

1.9.6 Stack Images Screen 
Normalise Flats checkbox is ticked by default
General improvements, Min 0 checkbox.

BeSS Settings screen
Added icon links to BAA Spectroscopic and ARAS databases
Validation message fix. If the wavelength used to calculate resolution is provided, 
then so is Effective SRP.

Echelle Extraction screen
Now extracts target and calibrations strips, when selections are made using flat 
image

H2O Correction screen
New screen to remove features caused by telluric water lines. This prototype is work
in progress.

Calibration menu
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The ‘New Calibration’ menu option is removed. – Use the ‘Remove Profile’ if 
necessary then click the ‘Create/Edit Calibration’ option

New ‘Use Minimal Calibration Text’ menu option – This displays just the calibration 
point wavelength. The vertical positions of calibration labels are also staggered to 
minimise overlap where the lines are congested.

Default colour of new profiles changed

1.9.7 UVES file import
UVES files, renamed with an ‘.uvs’ extension can now be imported. Once imported 
they behave as DAT files.

Performance optimisation, (resulting from UVES import work), has speeded up: 
Export of DAT text files, profile measurements and profile resampling.

Measurements & Elements screen 
Now supports element data files having intensity column
Element plots can use lines or scaled Gaussian curves 
Label option includes vertical or horizontal text
Element search can use sub filter (ionisation) field.
The following settings are now remembered.
* Element file name
* Significant figures
* Measurement report type
* Element tolerance
* Element label type add
* Element label text
* Element default colour

Labels & Annotations screen. 
New scaled element line annotation type.
Wavelength, Intensity and Element can be edited.
Data grid can be sorted by any column
Multiple rows can be deleted from Labels data grid
Arrow pointer allowed for some line types

Bulk Image Manipulations screen
Now supports mathematical operation using a 1D profile. 

FITS Header screen
New back and forward navigation buttons make it easier to look at header values 
across different profiles 
Limited validation of many critical FITS keywords

Cosmic & Hot Pixel screen 
Option to use ADU threshold or neighbour comparison
Option to allow detection and removal of hot or cold pixels
Option to specify median or average for correction
Tracker bar tooltip info now includes ADU count
Bad pixels list show ADU values

Black and White levels screen
Pixels above white ADU corrected as hot pixels
Pixels below black level corrected as cold pixels
Screen is now sizeable

General – Holding Control key will show mouse cursor position (XY value and flux) 
on an image

Bug Fix – Exposure time edit in BeSS screen would revert to previous value after 
save.
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1.9.8 TFITS and FITS files with a tabular data format can now be read. When a tabular 
FIT file is detected, the user is prompted to export to multi column data text file to 
display the profile, (using first two columns only).

Raw Image info is now displayed in LH status bar when X > 32768 pixels. Note: 
Image strip width is physically limited to 65,535 pixels (a .Net framework limitation).

RH status bar now allows text to be selected and copied to clipboard

More logging added (when LoggingLevel setting = 1 is set in confg. file)

Prompt for left or right label alignment to be set when adding molecule bands in 
Labels screen. Uses default Left where missing.

Black and White levels are now reset when creating a 1D profile following flux 
normalisation

BeSS settings – tab sequence updated and latitude/longitude buttons are 
enabled/disabled according to Site Location.

Stack Images - COMMENT keyword without leading "="

1.9.8b2 – fix false detection of FITS table when EXTEND=T. Logic is now NAXIS=0 
and EXTEND=T

1.9.8b3 – fix rounding & superfluous digits for wavelengths entered in Calibration 
Points screen

1.9.8b3 – BeSS screen. Projected Rotational Velocity field was incorrectly populated
with Radial Velocity.

1.9.8b3 – File Menu new options to open recent projects and profiles 

Correlation of two profiles screen – Work in progress. Needs password, can be 
supplied on request.

64-bit version  First version to be available in existing 32-bit version and new 64-bit 
version. Reconstruct Image screen uses 32-bit components so wont work with 64-bit
version

Doppler Utility tab – fix for velocity calculation when value is keyed in observed 
wavelength text box

1.9.8b4 – Result Option settings in Measurement Options tab of Measurement & 
Elements screen are saved.

Calibration Points screen
Calibration data points can be temporarily disabled by making the pixel value 
negative (by inserting a “–“ e.g. 123.45 to -123.45).

Region selection tool screen
A check box has been added to refresh the chart when the Update button is 
pressed.

1.9.8b5
Cross Correlation function screen is available for general usage, but still work in 
progress.  Accessing the screen from the Tools menu no longer requires a 
password.

Reconstrct Image  A warning message has been added to notify he user that the 
Reconstrct Image screen will only work with 32-it versions.
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1,9.9 BASS Project User Guide 
• Updated with changes since 1.9.7
• Amendment History prior to version 1.9.0 has been removed
• Troubleshooting section has been extended
• User Guide fix duplicate section numbers in chapter 2.2

Measurements & Elements screen
• Gaussian checkbox added (Measurement options tab)
• Reference Lamda drop down list (Measurement options tab)
• The summary statistics calculations will exclude invalid values.

Stack  and Align profiles
• Barycentre checkbox added for alignment

Chart – minor tick marks
• Tick marks on the chart axes can bet set in the X Axis and Y Axis tabs of 

the Chart Settings screen

Date & Time Setter screen – Modified Julian Date

• The Date and Time Setter screen  now includes a textbox to show and allow
keyboard entry using Modified Julian Date

Import of ELODIE profiles

• One dimensional ELODIE fits profiles can now be imported.

Image Strip View

On Windows XP operating system, images or profiles with width > 32767 pixels are 
always displayed in Stretch mode regardless of the setting in the Image Strip View 
drop down list. The reasoning is concerned with limitations of Windows XP.  

Configuration file setting to use zero for Empty data points

The default behaviour of BASS is to ignore Empty data points when rendering image
profiles.  Empty values are seen as NaN in the Edit Profile Values screen.  

The following setting added near the end of the BASSProject.exe.config will 
substitute 0 for Empty values when an image is loaded.

            <setting name="RawNaNAsZero" serializeAs="String">

                <value>True</value>

            </setting>

1.9.9b3 Bug Fix: BITPIX must be second keyword (fix to profiles created in the Resampling 
screen)

FITS header: Keyword BAS_MEX for BASS Project Universal Mid-exp Date added 

File menu: Maximum number of recent profiles and projects increased from 15 to 25

Chart settings: Can be edited to be edited when no profiles are loaded.

Profile Properties: File Rename message  makes it clearer that a new filename must
exclude path.

Region Selection tool:  now includes a Cross sectional plot  

Cosmic Hot & Cold poxels screen – Now supports bad row and bad columns in 
Cosmetic file. Bad pixel can be manually set at double click position (without 
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needing to be detected).

Stack Images screen: Cosmetic file is applied to all light, dark, flat, bias and flatdark 
images.
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